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Micro Focus Enterprise Developer 2.2
Update 1 for Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

Micro Focus Enterprise Developer Connect is for customers looking to use modern and productive
Enterprise Eclipse-based tooling to develop mainframe applications directly on the mainframe.
Developer Close integration to mainframe configuration management systems and the ability to
Connect easily customize the Eclipse-based IDE to include mainframe-based tools and

processes means developers can take full advantage of modern development tools
without having to learn new development processes.

Micro Focus Enterprise Developer is for customers looking to develop and modernize mainframe
Enterprise applications in a productive and modern Windows-based development environment,
Developer targeted for deployment onto an alternate server platform. Developers have the choice

of either the Visual Studio or the Eclipse-based IDE and development and test tools
are provided for all target environments currently supported by Micro Focus.

Micro Focus Enterprise Developer for IBM zEnterprise gives customers the choice to develop

Enterprise directly on the mainframe or under Windows. Mainframe applications can be

Developer for developed, maintained and modernized regardless of where they will be deployed,

IBM zEnterprise either back onto the mainframe or onto an alternative server environment. Support is
provided for both the Visual Studio and Eclipse-based IDEs and for all the
development and test tools for every target environment currently supported by Micro
Focus - including z/Linux, AlX and x86 environments. Enterprise Developer for IBM
zEnterprise combines all the capabilities of Enterprise Developer Connect and
Enterprise Developer.

Full mainframe integration and the Application Workflow Manager are only available in
the Eclipse-based IDE.

In addition, this document contains information on workflow modelling extensions in the section Enterprise
Developer for IBM zEnterprise Workflow Modelling Extensions .
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Note: The Enterprise Developer Personal Edition option is not available with this release. You can
use the Personal Edition with Enterprise Developer 2.1 Update 1 - you can register for it on the
Enterprise Developer Personal Edition section on the Micro Focus Web site.

i Note:

« Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.

Compiling for  Enterprise Developer for Visual Studio 2010 and Enterprise Developer for Visual

Enterprise Studio 2012 each target a different version of the COBOL run-time system - COBOL
Server or for Server 2010 and Enterprise Server 2012 respectively.

Enterprise . L . . .
Server 2012 Ensure that after you've edited the project in the preferred version of Visual Studio,

you compile your source code in that version of Enterprise Developer which targets
the version of the COBOL run-time in which you want your applications to run.

For example, if you build your application using Enterprise Developer for Visual Studio
2010 you cannot deploy the target files to Enterprise Server 2012; you must use
COBOL Server 2010.

v+, Important: Application executables that were compiled using earlier Micro Focus products must be
=" recompiled from the sources using Enterprise Developer. For more information, read the section
Upgrading to Enterprise Developer for Visual Studio 2010 in the product Help.

Micro Focus Enterprise Developer 2.2 Update 1 for Visual Studio Release Notes | 5
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Installation

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, it is recommended to have a minimum
of 2GB of RAM.

The disk space requirements are, approximately:

Windows
Platform Enterprise Developer Sentinel RMS License Manager
x86 Windows platforms 450MB 25MB
x64 Windows platforms 550MB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

6
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UNIX
The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:
Platform Setup Disk space Disk space Sentinel RMS
file size required for required for license server
(MB) the installation running (MB)
(GB) the product
(MB)
POWER running 414 1.66 828 33
AIX
HP IA 789 3.16 1580 61
System Z running 354 1.4 708 34
Red Hat Linux
x86-64 running 372 1.48 744 40
Red Hat Linux
SPARC running 442 1.77 884 38
Solaris
System Z running 359 1.44 718 34
SuSE SLES




Platform Setup Disk space Disk space Sentinel RMS

file size required for required for license server
(MB) the installation running (MB)
(GB) the product
(MB)
x86-64 running 377 151 754 40

SuSE SLES

Operating Systems Supported

Note: If you are using Enterprise Developer on a 64-bit operating system, you can produce either 32-
bit or 64-bit applications.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

i Note:

» This product can be installed on earlier versions of Windows but it has not been tested on them.

Software Requirements

Windows:

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Visual Studio IDE
This product requires any of the following versions of Visual Studio:

* A full version of Microsoft Visual Studio 2010 or 2012 Premium, Professional, or Ultimate edition, or the
respective version of Microsoft's Visual Studio Integrated Shell.

i Note:

* Microsoft Visual Studio Express Edition is not supported.

* You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If
you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

« If you do not have any of these versions of Visual Studio installed, the setup file will install the Visual
Studio Integrated Shell.

* Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

« Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.

* Microsoft NET Framework 4.5. This is included with Visual Studio 2012.

i Note:

« Visual Studio 2010 Service Pack 1 is required if you are using Enterprise Developer for Visual
Studio 2010 and Enterprise Developer for Visual Studio 2012 on the same machine. If you are
connected to the Internet, the setup file downloads and installs Visual Studio 2010 Service Pack 1
automatically. If you do not have Internet access, you need to download Visual Studio 2010
Service Pack 1 on a machine that has Internet connection, and then copy the installer to your
machine.

Installation
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« In addition, when building a native COBOL project that contains resources you must replace the
cvtres.exe in the bin and bin64 directories of your Enterprise Developer installation with the
version of the file which gets installed with Visual Studio 2010 SP1. You can download Service
Pack 1 for Visual Studio 2010 from the Microsoft Download Center.

UNIX/Linux:
These are the software requirements for Micro Focus Enterprise Developer Unix Components:

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

On Red Hat 6.x, you must have the following operating system libraries installed:

All Enterprise Developer products glibc-* x86_64

glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries required to use  gdb - the gdb packages (for the GNU Project Debugger) can
the core_on_error runtime variable be installed from the install media for your OS.

Addltlonal libraries for M_lcro Focus glibc-devel-* x86_64
Enterprise Developer Unix ) .
Components glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Enterprise Developer Unix glibc-devel-* s390

Components
3 glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The earliest supported release of Java 6 is 1.6
Update 27. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

i Note:

e On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AlIX JDK from IBM's Web site.

e On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:
JAVA _HOME=j ava_instal |l _dir

where java_install_dir is the path to the JAVA installation directory such as Zusr/java/Zjavan. n
You need to add $JAVA HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA HOME/bin:$PATH


http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1
http://www.microfocus.com/docs/links.asp?nx=redhat
http://www.microfocus.com/docs/links.asp?nx=java
http://www.ibm.com
http://www.hp.com

* You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Other Requirements

v+, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
== For local servers, you do not need to install it separately, as the setup file installs a new Enterprise
Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

« Application server support for interaction with Enterprise Server on page 9
e COBOL on Windows Azure on page 10

» Java Development Kit (JDK) on page 10

« Database Access on page 10

« Database Access - COBSQL (Pro*COBOL) on page 10

« Database Access - OpenESQL on page 11

« Database Access - HCO for SQL Server (HCOSS) on page 12
« Database Access - HCO for DB2 LUW on page 14

« Database Access - SQL Option for DB2 on page 14

« Enterprise Server for .NET on page 14

e Micro Focus Rumba on page 15

e WebSphere MQ on page 15

¢ Windows Forms on page 15

Application server support for interaction with Enterprise Server
Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface
Mapping Toolkit, as follows:

« Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
« Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following J2EE application servers are supported using the following JDKs:

J2EE Application Servers JDK (vendor) Java EE
JBoss 5 1.5/1.6 (Oracle) 5
JBoss 6 1.6 (Oracle) 6
Oracle WebLogic 10 1.5 (Oracle) 5
Oracle WebLogic 12 1.6/1.7 (Oracle) 6

Installation
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J2EE Application Servers JDK (vendor) Java EE

IBM WebSphere 7.0 1.5 (IBM) 5
IBM WebSphere 8.0 1.6 (IBM) 6
IBM WebSphere 8.5 1.6/1.7 (IBM) 6

COBOL on Windows Azure
Back to Top

Windows Azure requires additional software. See the Microsoft Windows Azure web site for a full list of the
required software, but the following is a summary of the main prerequisites:

« Windows 7, Windows Vista® SP1 or higher, or Windows Server® 2008
« Visual Studio's Visual Web Developer feature
*  Windows Azure Tools version 2.1 for Visual Studio - this includes the Windows Azure SDK

* Internet Information Services (11S) 7.0 - this must be installed and enabled, with ASP.NET, which is not
enabled by default

Java Development Kit (JDK)
Back to Top

Native COBOL and  Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to

Java Interoperability execute COBOL JVM code and for native COBOL and Java interoperability. The
earliest supported release of Java 6 is 1.6 Update 27. You can download Oracle's
Java EE from Oracle's Web site and install it anywhere on your machine.

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interfgce Mapping Restriction: This feature applies only when the Enterprise Server feature

Toolkit (IMTK) is enabled.

The JDK is required for generating Java interfaces from the Interface Mapping
Toolkit or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.
EJBs Use the same JDK vendor and version that is used by the
application server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, HCO for SQL Server (HCOSS), or OpenESQL, ensure any third-party software prerequisites
are installed and the environment is set properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top

y Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

10 | Installation
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Availability

XA Switch Module

Certification of
RDBMS
Precompilers for
Native COBOL

Feature/Platform 32-bit 64-bit

x86-64 running X X
Windows

The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. Certification
information can be found within the relevant Oracle documentation. If you have an
Oracle MetaLink account (http://metalink.oracle.com), document # 43208.1
provides details of all language compilers certified by Oracle for use with their
precompilers.

Preprocessors COBSQL supports the following database preprocessors:
» Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
» Oracle Pro*COBOL Version 11.1 (11gR1) or later
* Informix Embedded SQL/COBOL Version 7.3 or later
Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle,
do not use the COBSQL directive option NOMAKESYN, since this directive results
in COMP host variables, and on Intel platforms these are incompatible with the
native byte order expected by Oracle.
Back to Top
Database Access - OpenESQL
Availability Feature/ Native COBOL  Native COBOL 64-bit PL/I 32-bit
Platform 32-bit
x86-64 running X X X
Windows
XA Switch The ODBC One-phase Commit and the SQL Server XA switch modules are provided
Modules and are available on the same platforms as are indicated in the Availability section
above.
To build the SQL Server XA module, you must have the Windows Software
Development Kit (SDK) installed for your version of Windows.
Native « OpenESQL supports access to relational databases using ODBC 3.0-compliant
COBOL, .NET drivers
Managed

COBOL, and PL/I

.NET Managed
COBOL

Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

« OpenESQL has been tested against the following ADO.NET data providers:

* Microsoft provider for SQL Server

* Microsoft provider for Oracle

 IBM DB2

e Oracle Data Provider for .NET (ODP.NET)
e OleDb

e Managed ODBC .NET providers

Installation
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SQL CLR
Integration

SQL CLR
Integration

* Dynamic SQL using the SQL Descriptor Area (SQLDA) is not currently supported
for OpenESQL applications compiled with the SQL(DBMAN=0ODBC) directive.

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL CLR Database Project template require:

» Visual Studio Professional 2010, Premium 2010, or Ultimate 2010
*  SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

Projects based on the SQL Server Database Project template require:
< All of the following:

* Visual Studio Shell 2010, Visual Studio Professional 2010, Premium 2010, or
Ultimate 2010
¢ Subsequent installation of:

¢ Visual Studio 2010 SP1 (for any previously installed edition of Visual Studio
2010)
¢ Microsoft SQL Server Tools (SSDT SDK)
« Any of the following:

¢ SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

e SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR
v2.0 frameworks (2.0, 3.0, 3.5)

e SQL Server Azure targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR
v2.0 frameworks (2.0, 3.0, 3.5)

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL Server Database Project template require:
» Either of the following:

¢ Visual Studio Shell 2012 and Microsoft SQL Server Tools (SSDT SDK)
* Visual Studio Professional 2012, Premium 2012, or Ultimate 2012

« Any of the following:

e SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

* SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5), or .NET CLR
v2.0 frameworks (2.0, 3.0, 3.5)

e SQL Server Azure targeting .NET CLR v4.0 framework (4.0. 4.5) and also .NET
CLR v2.0 frameworks (2.0, 3.0, 3.5)

y., Important: The SQL CLR Database project template is not supported with
=" Visual Studio 2012. Projects based on the SQL CLR Database project template
are automatically upgraded to use the SQL Server Database project template
when opened in Enterprise Developer for Visual Studio 2010.

Database Access - HCO for SQL Server (HCOSS)

Back to Top



Microsoft SQL SQL Server 2008 R2 or SQL Server 2012, Developer or Enterprise Editions, including
Microsoft SQL Server Management Studio.

Server

Database
Migration

Application
Migration

Deploying
Native
Applications

¢ Microsoft .NET Framework 4.0
¢ Microsoft OLE DB Provider for DB2, available in the SQL Server 2008 R2 or 2012

Feature Pack

Note: Be sure to configure the OLE DB Provider to connect to the mainframe.
See your Microsoft documentation for details.

*« Mainframe DB2

f Note:

» We support only the mainframe DB2 versions that are currently under IBM

support.

« If you intend to develop applications on your local machine, but deploy
applications to a SQL Server database on a remote machine, you can install
SQL Server Native Client 10.x (or later) for ODBC connectivity on your local
machine instead of installing SQL Server. For information on configuring a
deployment machine, see the section Deploying Native Applications below.

ADO.NET
applications

COBOL Stored
Procedures

Development
Machine

Development
SQL Server
Machine

Deployment
Machine

Deployment SQL
Server Machine

ADO.NET applications require either of the following
combinations:

e SQL Server 2008 R2 and SqlClient Data Provider in .NET
Framework 3.5

e SQL Server 2012 and SqlClient Data Provider in .NET
Framework 3.5 or 4.0 (4.0 is preferred)3.5, 4.0, or 4.5 (4.x is
preferred)

See the requirements specified in the SQL CLR Integration
section under Database Access - OpenESQL in this topic.

« Enterprise Developer for Visual Studio 2010

» If SQL Server 2008 R2 or 2012 is not installed, you must have
Microsoft SQL Server 2008 R2 or 2012 Native Client installed

SQL Server 2008 R2 or 2012

Note: This can be the same machine as the
development machine, but is not required to be

* Enterprise Server or Enterprise Test Server installed

e If SQL Server 2008 R2 or 2012 is not installed, you must have
Microsoft SQL Server 2008 R2 or 2012 Native Client installed

If you want to bind your application from the deployment
machine, install the following software in addition:

» Microsoft .NET 3.5 framework, or later
* SQL Server 2008 R2 or 2012 System CLR Types
e SQL Server 2008 R2 or 2012 Shared Management Objects

SQL Server 2008 R2 or 2012

Note: This can be the same machine as the deployment
machine, but is not required to be

Installation
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Database Access - HCO for DB2 LUW

Back to Top
Availability

XA Switch Module

Certification of
RDBMS
Precompilers for
Native COBOL

Preprocessor

Host Compatibility
Option (HCO)

Feature/ Native COBOL Native COBOL 64-bit PL/l 32-bit
Platform 32-bit

x86-64 running X X X
Windows

The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

HCO for DB2 LUW supports the following database preprocessors:
e |IBM DB2 LUW Version 9.5 or later
* IBM DB2 Connect Version 9.5 or later

Host Compatibility Option requires that you have one of the following software
products installed and configured:

« |IBM Database Connect
< |IBM DB2 LUW Personal Edition or DB2 Express-C
« DB2 LUW Workgroup or Enterprise Edition

You must also install the DB2 Application Development Client (formerly called
DB2 SDK) or you will not be able to compile any DB2 programs.

Database Access - SQL Option for DB2

Back to Top
Feature/Platform 32-bit
x86-64 running Windows X

XA Switch Module XDB XA switch modules are provided and are available for the Windows x86-64 32-

bit platform.

Enterprise Server for .NET

Back to Top

e Microsoft .NET Framework 4.0
« Microsoft SQL Server 2008 R2. For beta or development installations, SQL Server Express 2008 R2 is

sufficient.

You can download Microsoft's SQL Server from http://www.microsoft.com/sqlserver/en/us/get-sql-

server/try-it.aspx.

e A TN3270 terminal emulator. Micro Focus Rumba is supplied with this product.

Note: You also need to enable IIS and some additional Windows features. Read the Quick Start
section in your Enterprise Server for .NET help for further instructions on how to set up your operating

environment.

14 | Installation
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Micro Focus Rumba

Back to Top

« On Windows 8, in order to install Micro Focus Rumba you must have the Microsoft .NET Framework 3.5

Service Pack 1 installed.

WebSphere MQ
Back to Top
IBM WebSphere MQ version 7 and later.

Windows Forms

Back to Top

« Microsoft Visual Studio is required for using the Interface Mapping Toolkit (IMTK) to generate Windows

Forms and ASP.NET Web site test clients.

« Microsoft Internet Information Service (1IS) is also required for generating Windows Forms test clients.

Additional Software Requirements for Micro Focus
Enterprise Developer Unix Components

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

e Application server support for JVM COBOL on page 15

» Application server support for interaction with Enterprise Server on page 16
» Java Development Kit (JDK) on page 17

» Database Access on page 17

« Database Access - COBSQL (Pro*COBOL) on page 17

« Database Access - OpenESQL on page 18

« Database Access - HCO for DB2 LUW on page 19

« WebSphere MQ on page 15

Application server support for JVM COBOL

Back to Top

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version
Tomcat 7.0.39 16/17 Servlets 2.5

JBoss 6.1 16/1.7 Servlets 2.5

WebLogic 12.1.1 16/1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR1I0 FP1 /1.7 Release 1 Servlets 2.5

WebSphere 8.5 16/1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.6.0 SR1I0 FP1 /1.7 Release 1 Servlets 2.5

y Note:

Installation
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e On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

» On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

e On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Application server support for interaction with Enterprise Server
Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface
Mapping Toolkit, as follows:

« Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
« Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following J2EE application servers are supported using the following JDKs:

J2EE Application Servers JDK (vendor) Java EE
JBoss 5 1.5/1.6 (Oracle) 5
JBoss 6 1.6 (Oracle) 6
Oracle WebLogic 10 1.5 (Oracle) 5
Oracle WebLogic 12 1.6/1.7 (Oracle) 6
IBM WebSphere 7.0 1.5 (IBM) 5
IBM WebSphere 8.0 1.6 (IBM) 6
IBM WebSphere 8.5 1.6/1.7 (IBM) 6

The availability of resource adapters for these Application Servers differs between UNIX platforms. The
following table indicates where support is available for each platform:

Feature/ JBoss 5 JBoss 6 Websphere Websphere Websphere Weblogic 10 Weblogic 12
Platform 7.0 8.0 8.5

AIX 6.1 on 32-bit 32-bit 32-bit 32-bit 32-bit 32-hit 32-bit
RS6000

HP/UX 11.31 32-and 64- 32-and 64- 64-bit 64-bit 64-bit 32-and 64- 32- and 64-
on Intel IA64 bit bit bit bit

Red Hat EL  32-hit 32-bit 32-bit 32-bit 32-bit 32-hit 32-bit

6.2 on

IBM390

Red Hat EL  32-hit 32-bit 32-bit 32-bit 32-bit 32-hit 32-bit

5.5 0on AMD

Opteron

Solaris 11 on 32- and 64- 32- and 64- 32-and 64- 32- and 64-
AMD bit bit bit bit

Opteron

Solaris 10 on 32- and 64- 32- and 64- 32-and 64- 32- and 64-
SPARC bit bit bit bit
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Feature/ JBoss 5 JBoss 6 Websphere Websphere Websphere Weblogic 10 Weblogic 12
Platform 7.0 8.0 8.5

SuSE SLES  32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

11 SP1on

IBM390

SuSE SLES  32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

11 on AMD

Opteron

Java Development Kit (JDK)
Back to Top

Compiling Java  Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interf:_ace ) Restriction: This feature applies only when the Enterprise Server feature is
Mapping Toolkit enabled.
(IMTK)

The JDK is required for generating Java interfaces from the Interface Mapping Toolkit
or the imtkmake command.

EJBs Use the same JDK vendor and version that is used by the application
server.

After installing the JDK, you need to set up your Java environment.

Database Access
Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, or OpenESQL, ensure any third-party software prerequisites are installed and the
environment is set properly.

Database Access - COBSQL (Pro*COBOL)
Back to Top
f Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit
x86-64 running Red Hat X X
Linux
x86-64 running SUSE X X
Linux
IBM System p running X X
AlIX
IBM System z running X X
SUuSE Linux
Itanium running HP-UX X X
x86-64 running Solaris X X
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XA Switch
Module

Certification of

RDBMS

Precompilers for
Native COBOL

Preprocessors

Compiling

Executing

Feature/Platform 32-bit 64-bit

SPARC running Solaris X X

The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. Certification information can be
found within the relevant Oracle documentation. If you have an Oracle MetaLink
account (http://metalink.oracle.com), document # 43208.1 provides details of all
language compilers certified by Oracle for use with their precompilers.

COBSQL supports the following database preprocessors:

¢ Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
e Oracle Pro*COBOL Version 11.1 (11gR1) or later
¢ Informix Embedded SQL/COBOL Version 7.3 or later

On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle, do
not use the COBSQL directive option NOMAKESYN, since this directive results in
COMP host variables, and on Intel platforms these are incompatible with the native
byte order expected by Oracle.

On HP-UX, to execute an application precompiled using Pro*COBOL (or COBSQL)
after you have created a callable shared object of Oracle DBMS routines, you need
set an environment variable, LD_PRELOAD, to point to the Oracle client callable
shared object, for example:

LD_PRELOAD=$0RACLE_HOME/I i bdi r /libclntsh_.so
export LD_PRELOAD

where libdir is:

* |ib32 for 32-bit environments
* |ib for 64-bit environments.

A script is available that creates an executable run-time system or a callable shared
object containing Oracle support. You can find the script in the Micro Focus
Knowledge Base article titled Building and executing Pro*COBOL applications on
UNIX.

Database Access - OpenESQL

Back to Top
Availability

Feature/ Native COBOL Native COBOL 64-bit PL/I 32-bit
Platform 32-bit

x86-64 running X X X
Red Hat Linux

x86-64 running X X X
SuSE Linux

IBM System p X X X
running AIX

IBM System z X X

running SuSE
Linux



HTTP://METALINK.ORACLE.COM

Native COBOL

Database Access - HCO for DB2 LUW

Back to Top
Availability

XA Switch Module

Certification of
RDBMS

Precompilers for

Native COBOL

Preprocessor

Feature/ Native COBOL Native COBOL 64-bit PL/I 32-bit
Platform 32-bit

Itanium running X X

HP-UX

x86-64 running X X

Solaris

SPARC running X X X

Solaris

OpenESQL supports access to relational databases using ODBC 3.0-compliant

drivers

Refer to your driver vendor's documentation to determine whether your driver is

suitable for use with OpenESQL

Feature/

Native COBOL

Native COBOL 64-bit

PL/I 32-bit

Platform 32-bit

x86-64 running X X X
Red Hat Linux

x86-64 running X X X
SUuSE Linux

IBM System p
running AIX

IBM System z X X
running SUSE
Linux

[tanium running X
HP-UX

x86-64 running
Solaris

SPARC running X X

Solaris

The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

HCO for DB2 LUW supports the following database preprocessors:

« |[BM DB2 LUW Version 9.5 or later
*« |BM DB2 Connect Version 9.5 or later
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Host Compatibility Host Compatibility Option requires that you have one of the following software
Option (HCO) products installed and configured:

* IBM Database Connect
« |IBM DB2 LUW Personal Edition or DB2 Express-C
e DB2 LUW Workgroup or Enterprise Edition

You must also install the DB2 Application Development Client (formerly called DB2
SDK) or you will not be able to compile any DB2 programs.

WebSphere MQ
Back to Top
IBM WebSphere MQ version 7 and later.

Installing Enterprise Developer for Visual Studio

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

You can download Enterprise Developer for Visual Studio 2012 from the Micro Focus SupportLine Web
site and from the Product Updates section.

Product Co-Existence

« Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

* Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

« Enterprise Developer is available in different IDE variants, each one of which is targeted by one specific
variant of the development product:

» Enterprise Server - the deployment environment for COBOL applications created with Enterprise
Developer for Visual Studio 2010 or Enterprise Developer for Eclipse

« Enterprise Server 2012 - the deployment environment for COBOL applications created with
Enterprise Developer for Visual Studio 2012

You can only deploy applications to the specific variant of Enterprise Server that is targeted by the
Enterprise Developer variant used to build the applications. For example, if you build your application
using Enterprise Developer for Visual Studio 2012, you can only deploy the target files to Enterprise
Server 2012. The application will not run in Enterprise Server.

Installation restrictions and requirements

Before starting the installation you should consider the following:

« If, when you install Enterprise Developer for Visual Studio 2010, the machine does not have Microsoft
Visual C++ 2010 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number
of _dl1 files, without digital signatures, into the winsxs directory.
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« If, when you install Enterprise Developer for Visual Studio 2012, the machine does not have Microsoft
Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dl1

files, without digital signatures, into the winsxs directory.

< If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

* You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_ CLASSES ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

« Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an Enterprise Developer command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol” port is used (86) and this can only be used by one process at a time

Installing and Licensing Micro Focus Rumba

The Enterprise Developer installer includes Micro Focus Rumba 9.0 which you can optionally install. The
license for Enterprise Developer enables you to use the mainframe components of Rumba (Rumba for
Mainframe).

Before using the Enterprise Developer installer to install or update Rumba, please note the following:

< If you have the full, standalone version of Rumba installed on your machine, it is recommended that you
use the standard ways to upgrade this version to Rumba version 9.0 or later.

It is not recommended to use the Enterprise Developer 2.2 Update 1 setup file to update Rumba as you
may lose your license for the full Rumba version.

« If you are installing Enterprise Developer 2.2 Update 1 onto a machine that does not have Rumba
installed, it is recommended that you select the Rumba option and install this with Enterprise Developer.

Installation
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This installs the components you need to establish a mainframe 3270 connection (Rumba for
Mainframe) and a 30-day trial license for the full Rumba product. After the 30-day trial period completes
you will still access Rumba for Mainframe components as part of your Enterprise Developer license.

If you are installing Enterprise Developer 2.2 Update 1 as an upgrade to an existing licensed installation
of Enterprise Developer that is using an authorization code issued before Enterprise Developer 2.1
Update 1 (released in April 2013), it is recommended that you do not update the Rumba components
previously installed with the earlier version of Enterprise Developer.

If you do want to update Rumba, then select this during the 2.2 Update 1 installation and then contact
Micro Focus SupportLine and ask for the Enterprise Developer 2.2 Update 1 authorization code. This
will replace your existing 2.1 authorization code and will enable the updated version of Rumba.

Installing as an Upgrade

This release will update existing installations of Enterprise Developer 2.2.

Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files
not being installed.

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Installing

f Note:

Before installing, check Installation Restrictions and Requirements.

« See Installing as an Upgrade first for important information when upgrading an existing installation
of Enterprise Developer.

» This version of the product is a full install.

To install this product:

1.

Run the edvs2010_221_exe (edvs2012_22_exe when installing the product for Visual Studio 2012
when installing the product for Visual Studio 2013) file and follow the wizard instructions to install the
prerequisite software and the product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba.

f Note:

e When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a Microsoft's known problem. To resolve
it, follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

« If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.


http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1

« Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

*  We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

« If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Enterprise Developer Installation Options

To install Enterprise Developer you run edvs2010_221 . exe which contains a number of product -.msi
files (Windows Installer packages). When run, edvs2010_ 221 .exe performs some initial system checks
then sequentially installs the .msi files.

Note: The following applies to edvs2012_ 22 _exe when installing the product for Visual Studio 2012.
The following applies to edvs2013_22.exe when installing the product for Visual Studio 2013.

edvs2010_ 221 .exe can take a number of parameters, enabling you to specify a number of different
types of installation:

+ Standard Installation

Format:
edvs2010_221.exe
Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.
» Non-interactive Installation

Format:

edvs2010_221.exe /passive

Summary:

Full installation, but the components are installed non-interactively using default options and
directories.

¢ Silent Installation

Format:
edvs2010_221.exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
* Modified Silent Installation

Format:

edvs2010_221.exe /q InstallFolder=d:\otherdirectory

Summary:

Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:z\otherdirectory.

Format:

edvs2010_221.exe /q RumbaCheckbox=1

Summary:

Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components
are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2010 221 .exe /7.
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Note:

* Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Microsoft Terminal Server

You can use this product with Microsoft Terminal Server but note that a separate end-user license is
required for each user who accesses it, even if the product is running on a single machine. See your End
User License Agreement.

Microsoft Terminal Server is an environment for running multiple instances of a single-user product. It is
not a platform where a single-user product can be made to perform as a multi-user product.

To install onto a terminal server:

« Log on to the physical terminal server with a user ID that has administrator privileges.
* Use Control Panel > Programs and follow the instructions on the screen.

When you install the product on Microsoft Terminal Server or similar terminal software, do not execute
more than one installation at the same time.

When you install Microsoft Terminal server, you must assign a unique port address to each user. Then the
very first time that each user logs into Enterprise Developer and starts the terminal server, they should:

1. Select Options > Project > Port address for Web Server.
2. Type in the assigned port address.

This is necessary because the default port address for the Web server is 80. Once this has been allocated
to the first user, when the next user attempts to start the Web server, the software recognizes that this port
is in use and rejects the attempt. Consequently each user requires an individual port address.

Installing from a Server

There are two methods for installing this product on users' machines using a server. You can:

« Copy the product onto the server and then use Setup under control of a third-party software distribution
package, such as Microsoft's Systems Management Server (SMS), to install the product onto multiple
users' machines.

This method of installation and the associated file are not supported by Micro Focus. They are provided
on an "as is" basis and have not been tested in any form. You can use them at your own discretion.
« Install onto the server. Then users run Setup to install from the server onto their own machines.

Both methods give you control of what options the user can install and mean you do not have to send the
installation media to every user, as they install from the server instead.

Windows Compatibility Mode

In Windows Vista and Windows Server 2008, if you have problems starting Enterprise Server instances
using the Micro Focus Enterprise Server Administration HTML GUI, ensure that none of the Enterprise
Server program files are configured to use a Windows compatibility mode. You can check for compatibility
modes by examining the file properties for the program file using Windows Explorer:

1. Open the Properties dialog box for the file.

2. Click the Compatibility tab.

3. Ensure that Run this program in compatibility mode for is not checked.
4

. Click Show settings for all users and ensure that Run this program in compatibility mode for is not
checked.



5. Click OK on both dialogs to update the file properties.
Verify that <i nst al | - di r >\base\bin\mfds.exe is not set to run in a compatibility mode.

« For 32-bit Enterprise Server, check bin\cas*.exe and bin\mfcs.exe
« For 64-bit Enterprise Server, check bin\win64\cas*.exe and bin\win64\mfcs.exe.

After Installing

You are now ready to run Enterprise Developer. From the Windows taskbar click Start > All Programs >
Micro Focus Enterprise Developer > Enterprise Developer for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8 and Windows Server 2012. You use the Start
screen to invoke programs.

Note: For applications created with earlier Micro Focus products or earlier versions of Enterprise
Developer, note the following:

Database Managed applications using SQL(DBMAN=0ODBC) that were compiled in

Access Enterprise Developer 2.1 Update 1 must be recompiled in Enterprise Developer
2.2 Updatel.

Existing Application executables that were compiled using earlier Micro Focus products

Applications must be recompiled from the sources using Enterprise Developer. For more

information, read the section Upgrading to Enterprise Developer for Visual
Studio 2010 in the product Help.

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

i Note:

The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer
1.0, which does not include an index for the locally-installed help. Navigation of the content is only
available using the table of contents and Search and the help contents for the Help system does
not expand and collapse in the same way as previous Help systems.

« If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help
Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems
> Choose online or local help and check the | want to use local help button.

» Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which
provides a stand-alone help viewer with an index and a fully expandable table of contents.

e If you do not want to install Visual Studio 2010 SP1, you can install some third-party tools that
enable the index or the fully expanding table of contents. For more information, see the topic Help
on Help.

* To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

» For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

» On Windows 8 and Windows Server 2012, an issue with Microsoft Help Viewer 2.0 and Internet
Explorer's security being turned on can cause the Help content to be displayed as raw HTML
code. To resolve the issue, you need to turn off the Internet Explorer Enhanced Security
Configuration (IE ESC) for both administrators and users. Check the Microsoft Windows help for
more information on how to do this.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
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To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Installing Micro Focus Enterprise Developer Unix
Components

f Note:

» Micro Focus Enterprise Developer Unix Components is only available with an Enterprise
Developer or Enterprise Developer for IBM zEnterprise license and is not available with an
Enterprise Developer Personal Edition license.

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing

f Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server

process (Enterprise Server Administration) runs as root as this allows it to access the system files and

ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To

change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.
These are the steps to install this product:

1. Give execute permissions to the setup file:
chmod +x setup_entdev_2.2 updatel pl atform
2. Run the installer from the Process User ID login:
-/setup_entdev_2.2 updatel platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations

that require root permissions.

The COBOL environment is installed by default into Zopt/microfocus/EnterpriseDeveloper,

(COBDIR).

To install in a different location use the -instal llocation="Location" parameter to specify an

alternative directory location. For example:

./setup_entdev_2.2 updatel platform -installlocation="full path of new
| ocation™



i Note: You can use variables or the tilde syntax for the path for —instal l location. For
example, the following examples are equivalent:

-installlocation="/home/myid/i nstal | di r*
-installlocation="~myid/instal | di r™
—-installlocation="~/instal I dir"
—-installlocation=""$HOME/i nstal | di r **

You can see details about which additional parameters can be passed to the install script if you enter
the —help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="l ocation" ] [ -ESadminID=""User ID" ] [ -CASrtDir="1ocation" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog=""/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, ~-EDadminID=""esadm". The default user ID is the one that runs the
installer.

-CASrtDir  Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

i Note:

« The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:
./setup_entdev_2.2_updatel_pl atf or m -skipsafenet

» To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

1. To set up your product, execute:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv
2. To verify that your product is installed, execute:

cob -V

¢, Important: These commands set the environment only for the current shell. You need to execute
=" them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
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Installing silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:
—silent -lacceptEULA

For example, execute:
[as root] setup filenane —silent -lacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the Internet Run the following as root:

and an authorization code cd /var/microfocuslicensing/bin
./cesadmintool .sh -authorize Aut hori zati onCode

If you don't have access to the Run the following as root:

Internet but have a file from Micro  ¢d /var/microfocuslicensing/bin
Focus that contains the license ./cesadmintool .sh -install Fil eNane
string

where FileName is the name of the text file that contains all the
license strings to be used.

UNIX and Linux Installer Issues

Installing on On Linux, the 32-bit version of Java is required to install and use Enterprise Developer

Linux for Eclipse. When you start the installation, if the 64-bit version of Java is already
installed on your Linux machine, you might not be able to install Enterprise Developer.
This is a known issue with the Oracle Java installers for Linux which prevent you from
installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

» Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

» Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in Zusr/local/
Java.

 Set JAVA_ HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Enterprise Developer.

License « On some Solaris platforms, you can receive the following error message when
:nfrtaTItructure SafeNet license server needs to be installed or upgraded on your machine:
nstaller

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerinstall.sh

. Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).


http://www.oracle.com/technetwork/java/javase/install-linux-64-rpm-138254.html

Certain configuration changes in RHEL 7 (such as the Zetc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour — for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in Zusr/1ib/systemd/system/ with the
following contents:

——————————— start of /usr/lib/systemd/system/
MFSafeNet.service —-—-———---————-
[Unit]
Description=Micro Focus SafeNet licensing daemons.
Documentation=http://supportline_microfocus.com

[Service]

Type=forking
ExecStart=/var/microfocuslicensing/bin/startboth.sh
ExecStop=/var/microfocuslicensing/bin/stopboth.sh
Restart=no

[Install]

WantedBy=multi-user.target
——————————— end of Zusr/lib/systemd/system/
MFSafeNet.service -—---—-—--—--———-

2. Use the systemctl command to manage the SafeNet service:
[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root

privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.

enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
0sS.

License Server You need to configure the computer hostname to ensure the license server will start
properly.
To avoid performance issues, "localhost” and the computer hostname must not both be

mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.
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The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.| ocal domai n localhost

| P machi nel onghost name machi neshort host name

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Installing Mainframe Access Server

Note: Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.

Introduction

The installation process for Mainframe Access Server (MFA) uses a single FTP operation to transfer all of
the mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.

Requirements

e IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher

e Two APPLIDs, two TCP/IP ports

« Availability of APF security authorization support personnel

« Access to a network share with acceptable space for source and data, as well as the ability to access
the IP address and ports used to access MFA

* The following installation-specific variable information:

Variable Description

drive

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

- Important: The installation of a new version of MFA creates new product run-time data sets
== pefore the upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can
be used for fallback. If you prefer to retain your former production library names and re-use your
existing prodhlg, rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFMO0001I and MFM0014I1 on the syslog and XDBOUT sysout data set show the maintenance



level at startup. You may need to know what level you are upgrading from when you complete
post-installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlg.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlg.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO <=== PDS (partitioned data set)
RECFM=FB <=== record format fixed and blocked
LRECL=80 <=== 80 character record size
BLKSI1ZE=3120 <=== 3120 character block size

SPACE=(3120, (3500,500,50)) <=== allocate blocks (BLKS) size 3120

3500 primary blocks
500 secondary blocks
50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.

a.

Start FTP:

C:\>ftp your. nai nfrane. nane

Connected to your. nmai nfrane. nane.

220-FTPD1 IBM FTP CS/390 VxRy at YOUR. MAI NFRAME. NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your. mai nfrane. nane:(none)): userid

331 Send password please.

Password: pswd

230 userid is logged on. Working directory is "userid.".

Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd “prodhl q.UPLOAD"
250 The working directory "hlq.UPLOAD" is a partitioned data set.

Set file transfer type to binary

ftp> binary

200 Representation type is Image

Set FTP prompting off to transfer all files without interruption:
ftp> prompt

Interactive mode OFf.

. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

ftp> mputdrive:\upload\f*

200 Port request OK.

125 Storing data set prodhl g-UPLOAD(FXXXXXXX)

250 Transfer completed successfully.

ftp: xxxx bytes sent In X.xx seconds (xXxx.xx Kbytes/sec)

When mput has transferred all files the Ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.

. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the

\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.
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4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlqg within your MFA sample started
task procedures as provided by Micro Focus. The prodhlg.LOADLIB and prodhlg.SASC.LINKLIB must both
be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:
MFMO0O11: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA3031 MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS. ..

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect
MFAAS sample MFAAS application server started task
MFAVTAM sample MFA VTAM definitions

PARMS sample PARMS for MFA started task

PARMSAS sample PARMSAS for MFAAS started task
SERVERS sample SERVERS configuration for MFA
UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
need to modify the MFAS started task JCL since the module names for Data Connect have been changed
to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Uninstalling

Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
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2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e The Micro Focus Product Nane folder in the Start menu - you can delete it manually.

« Y%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.

* %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.

 %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /Zuninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

* Micro Focus Server\Performance\Active Servers
* Micro Focus Server\Performance\PerflniFile

UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.2.sh scriptin the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
i Note:

» If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

» The Enterprise Developer Personal Edition option is not available with this release. You can use
the Personal Edition with Enterprise Developer 2.1 Update 1 - you can register for it on the
Enterprise Developer Personal Edition section on the Micro Focus Web site.

* Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if
you wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license

To buy a license for Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise
Developer help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

f Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
Click the Install tab.
3. Do one of the following:

N

* Click Browse next to the License file field and select the license file (which has an extension
of .mFlic).
» Drag and drop the license file from Windows Explorer to the License file field.
« Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

Licensing Information


http://online.microfocus.com/Enterprise-Developer-PE
http://supportline.microfocus.com/
http://supportline.microfocus.com/

1. Start Enterprise Developer.

Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog
box.

Ensure | have a full Enterprise Developer Team Edition license is checked.

Click Browse next to the License file field.

Select the license file (which has an extension of .mflic), and then click Open.

Click Authorize to install the license.

n

o gk w

You should see a dialog box with a confirmation that the licenses have been installed successfully.

If you have an authorization code

Authorizing your product when you have an Internet connection
f Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Start Micro Focus License Administration.

Click the Install tab.

Type the authorization code in the Enter authorization code field.
4. Click Authorize.

w N

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
y Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Start Micro Focus License Administration.

Click Manual Authorization on the Install page.

Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:

HwbhpPE

« If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

< If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
Type the Machine ID in the Machine ID field.
Type your email address in the Email Address field.
Click Generate.
Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

© N
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10.Click Install Licenses.

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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New Features in Enterprise Developer 2.2
Update 1

This release provides enhancements in the following areas:

Visual Studio IDE

This release provides the following enhancements to COBOL support in the IDE:

Expanded (Visual Studio 2012 only.) The Expanded Copybook View functionality in the editor
Copybook View was added in the 2.2 release and this has been enhanced in 2.2 Update 1 so it is now
possible to debug into the expanded copybooks. The functionality includes:

» Stepping inline in the expanded copybook view when debugging - when stepping
into or hitting a breakpoint in the copybook, the copybook automatically expands.
You can disable this feature from the IDE preferences.

» Showing Pinned Data tips inside the expanded copybook.

» Support for QuickWatch and Add Watch inside the expanded copybook.

» Executing some of the debugger commands from the context menu from the
expanded copybook view - for example, Show Next Statement, Run To Cursor
and Set Next Statement.

Some limitations apply.

Call Hierarchy  (Visual Studio 2012 only.) Enterprise Developer now supports the Visual Studio Call
Hierarchy window for analyzing COBOL PERFORM statements.

Find All The Find All References functionality now works for managed OO COBOL code.

References

Navigation You can now use Alt+Shift+Up Arrow (or Down Arrow) to navigate the variables in the
editor.

You can use the drop-down types and members to navigate to the different sections
(Linkage section, File section etc.) in your source files.

Project Details  The Project Details Window now includes columns showing the COBOL dialect of
Window the files and the SQL properties set on them.

Run-Time  You can now use the application configuration file (application.config) in
Configuration native COBOL projects to specify some additional settings such as the search
order for called programs, command line handling, or file handling. You can do this
from the new Run-Time Configuration tab.
« When an executable is built using the IDE, the application configuration file is
automatically copied to the output folder and is renamed as <execut abl e- base-
name>.exe.mfgct.

Samples This release includes the following new samples:

e Airport Demo (managed) - shows how to create a COBOL WCF REST service and
then use a client application to consume it.

» Airport Demo (native) - a basic lookup program that reads the information about
airports from a .dat file and outputs the distance between two airports.
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The Sandcastle sample has been updated and now uses Sandcastle Help File Builder

v1.9.8.0.
Solution (Visual Studio 2012 only.) Support is now available in Solution Explorer for the
Explorer following features:

Errors and warnings filters - click the arrow next to the “(Pending Changes

Filter) icon in the Solution Explorer toolbar, and either click '®Errors Filter or e
Errors and Warnings Filter to show the files that result in errors or also cause
warnings.

» Searching in Solution Explorer - You can use the search field in Solution Explorer
to search for files in your solution. Searching also finds copybooks in the copybook
dependency view even if they are not part of any of the projects in the solution.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

Btrieve Support

Support for the Btrieve file handling system from Pervasive Software Inc. has been added into Enterprise
Developer.

Support is restricted to native COBOL, in a Windows environment.

COBOL Source Information

The Quick Browse option is now available as a context menu command in the editor.

Compare and Synchronization Monitor

With the release of Enterprise Developer 2.2 Update 1, the Compare and Synchronization Monitor has
been updated to version 2.

Version 2 is greatly improved in terms of performance, especially during initial checkout of partitioned data
sets or when synchronizing a large number of members. Also, the user interface has been improved, and
some of the functions available in the old version have now changed or become obsolete.

Compiler Directives

The following Compiler directives have been added in this release:

ILPARAMS Determines the way in which you call a method that contains an array as its last receiving
parameter.

INIT-BY- Initializes Working-Storage Section data items to a default value, according to their type.

TYPE . . . . . o L
Alphabetic, alphanumeric, alphanumeric edited, and numeric edited items are initialized

to spaces.
* Numeric items are initialized to zero.
* Pointer items are initialized to null.
* Index items are initialized to the value 1.

Database Access

The following new features have been added as part of database access support:

38 | New Features in Enterprise Developer 2.2 Update 1



HCOforDB2 . gypport added for DB2 LUW version 10.5.
LUW » Enhanced RETURN-CODE processing.

e The HCO DDL processor now accepts column names with a length greater than 18
characters.

* The HCO Import Data tool now processes CLOB data less than 32K in size.

* The HCO Import Data tool can now convert DSNTIAUL import files to delimited
format, enabling the actual import to be done by DB2 LUW IMPORT and LOAD
utilities. This is done using the new SAVEDEL and CHARDEL parameters.

HCOfor SQL . support for the mainframe SET CURRENT SQLID statement.

(S:(r:\é)e;s) e Support for the mainframe LEFT and RIGHT scalar functions.

» Data Migration tools now support the mainframe ALIAS and SYNONYM objects.
OpenESQL « Enhanced internationalization support for UNICODE, DBCS and MBCS.

» Enhanced GET DIAGNOSTICS statement support.

« Enhanced LOB support for CLOB, BLOB and DBCLOB data types.

* ADO.NET connection editor now provides context help.

* Enhanced IDE support for OPTION directives.

» Now provides support for the creation of save points and rolling back to save points.
XA Switch Restriction: This feature applies only when the Enterprise Server feature is
Modules enabled.

* New two-phase commit module for SQL Server based on Microsoft's XA switch.
This provides support for xa_recover.

e Support for DB2 LUW version 10.5.
» Support for Oracle version 12.1.

Enterprise Server Integration in the IDE

You can now use the context menu for the servers in Server Explorer to enable the display of the
Enterprise Server log information in the Output window.

Enterprise Server MQ-IMS Bridge

v+, Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
= finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.

This release provides support that enables WebSphere MQ applications to communicate with IMS
applications in an Enterprise Server region.

Environment Variables

The following environment variable has been added in this release:

strictvsam strictvsam enables strict mainframe emulation when processing VSAM files.

When set to ON and running under mainframe emulation, file status 37 is returned for an
existing VSAM file when opened for OUTPUT if the file has data or previously had data
written to it, or if the file is of a different format to the file on disk. When set to OFF, file status
0 is returned and a new file is created when an existing VSAM file is opened for OUTPUT.
This variable is set to OFF by default.

Fileshare Recovery

Recovery of Fileshare data files has been enhanced.
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Rollback recovery is a faster process that aims to fix the files from their failed state.

This process cannot be used in all scenarios, but a new user exit has also been introduced that allows you
to programmatically control which files you wish to recover with this process.

Hot backups are also a new introduction, which allow you to perform a backup without having to shut down
Fileshare.

Line Numbering for COBOL Programs

This release provides options for auto-inserting or removing line numbers in source files open the editor.
Features include:

e COBOL numbering - line numbers are inserted in the sequence area of the code (columns 1 - 6),
starting at 000100 at the first line, and incrementing by 100.

If it recommended that you use COBOL numbering only if your files are in fixed or variable source
format.

e Standard numbering - line numbers are inserted immediately to the right of area B, in columns 73 - 80,
starting at 00001000 at the first line, and incrementing by 1000.
If it recommended that you use Standard numbering only if your files are in fixed format.

* The Renumber and Unnumber commands available from the context menu in the editor.

Local Catalog

From within Server Explorer in the IDE, you can add one or more local catalogs, and then use them in
conjunction with Drag and Drop to drag down data set items from your mainframe, edit them and then
move them back to the mainframe or to your testing environment.

Mainframe Emulation

Previously, MGMTCLAS was supported by simply saving it on the catalog record when a dataset was
allocated in JCL using the MGMTCLAS parameter on the DD statement. Starting with this release, you can
use batch jobs to define MGMT classes and to specify the EXPIRE AFTER time (in days).

Mainframe Subsystem

Casspool As part of an enhancement to improve performance when browsing the spool queue of
performance  an Enterprise Server, you must update the casspool file for any Enterprise Server
enhancement created before Enterprise Developer 2.2 Update 1 before you can submit jobs to it.

To update the casspool for each Enterprise Server, from a command prompt, run
Tixcasspool .bat, located in %COBDIR%\bin and %COBD IR%\bi1n64, using the
following syntax:

fixcasspool .bat casspool.dat backup.dat

Where:
casspool.dat

The spool file, located in the same directory as the Enterprise
Server's system catalog, that will be updated.
backup.dat

A file that will be created with a backup of the old casspool .dat
file. If backup.dat already exists, the update is not run.

If you do not update casspool and attempt to start Enterprise Server, the following
messages are displayed in the console:

JESOO00011E Batch Spool File Error; Status [39]
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JESOO0130E Note JES000011 Error - New casspool indexes may need
generating. See error description in product docs

Managed COBOL Syntax

This release includes the following enhancements to the managed COBOL syntax:

Specifying parameters in  You can now specify passing parameters and returning items in the method

the method signature signature, instead of using a Procedure Division header. This applies to
methods, indexers, iterators, constructors and delegates.

CONSTANT keyword Use the CONSTANT keyword on a field to protect it from being altered.

Operations on string You can now use the STRING, UNSTRING and INSPECT statements on

fields fields of type string.

PL/I

PL/I support within the IDE now includes the following enhancements:
e Support for new built-in functions

The PL/I Compiler and Runtime now support the following new built-in functions:

DAYS
DAYSTODATE
SECSTODATE
SECS
WEEKDAY
DAYSTOSECS
ONSUBCODE
REPATTERN
IAND

IOR

INOT
OMITTED
XMLCHAR

This provides an improved functionality and a greater language compatibility when you migrate
applications from a z/OS environment.
e Support for %OPTION in the PL/I macro preprocessor

You no longer need to modify application code that uses %OPTION in order for it to compile
successfully.
e Support for QUOTE() and COMMENT() built in functions.

This enables the use of PL/I macros that generate code using these built-in functions.
e Support for IBM Style %INCLUDE(S) that utilize PDS name as part of include file names.

The PL/I macro preprocessor now parses the %INCLUDE syntax of the form shown below and utilizes
the —isuffix and —ipath Compiler directives to locate the “member”.

%INCLUDE MYPDS(MYMEMBER) ;

This provides an improved language compatibility with the application code without the need to modify
the original underlying source code.

e Support for PL/I AREA data items up to 2Gb.

Open PL/I now supports the declaration and usage of variables of type AREA up to 2Gb in size. This
provides you with improved functionality and greater language compatibility when migrating applications

New Features in Enterprise Developer 2.2 Update 1 | 41



42

from a z/OS environment as there is no need to modify the code in order to deal with a maximum area
size of 32Kb.

« Enhanced compatibility with the DISPLAY () REPLY() syntax.

The PL/I Compiler and runtime now provide a DISPLAY() REPLY() syntax that is no longer dependent
upon the use of the SYSIN and SYSOUT DD’s and that no longer causes behavioral differences if
stream 10 to SYSIN/SYSOUT is intermingled with programs using DISPLAY () REPLY/().

« Support for big-endian style bit strings on little-endian platforms.

Using a new Compiler directive —bitsltr to compile programs that have logic that is dependent on big-
endian bitstring ordering enables you to utilize the code unchanged on Open PL/I little-endian platforms
(such as Windows, Red Hat Linux, SUSE Linux). This enables you to migrate applications that make an
assumption about bit ordering on the underlying operating system or hardware and to run them
unchanged.

« Support for the —initcall Compiler directive.

Compiling a PL/I program with the —initcall directive causes the specified program to be invoked prior to
any user logic. This enables you to customize your environments and do things such as tracking which
routines have been invoked, detect memory corruption prior to routine startup, establish database
connectivity.

» Support for the “F” option in PLIDUMP.

A PLIDUMP which was generated using the “F” option will now attempt to list all known information
about files which have been accessed during the execution of the program and includes information
about the last 10 operation, key values, and a dump of buffers, if available. This enables you to identify
more easily the cause of file-related failures and what file operations were in progress at the time of
failure.

» Early Adopter support for PL/I data structures Data File Tools.

In the IDE, you can now generate a PL/I structure map (.str) which can be utilized by the Data File
Tools utility to generate a formatted layout for a PL/I Data File. The PL/I data structure must be
compiled in advance with the -adt Compiler directive. This enables you to see what is in each field
within a PL/I data file record, and to modify them in a logical way without having to know the offset,
length and raw format of the data item.

« Support for PL/I debugger naotification for ON Unit invocation.

You can now request that the debugger stops when a PL/I ON Unit is about to be triggered. This
enables you to locate the ON Unit, establish appropriate breakpoints within the ON Unit and determine
the cause of the ON Unit being triggered.

« Support for PL/I debugger natifications for the load of shared libraries and .dll files.

You can now request that the debugger issues a natification when a shared object or a .dll file has been
dynamically loaded. This enables you to stop a program when a dynamic program has been loaded and
to establish the appropriate breakpoints, watch lists, etc.

» Alternative Index Performance Improvements for the CASSPOOL command.
* Support of the SHAREOPTIONS property in a VSAM cluster.
« Support for setting directives automatically for PL/I files.

In Visual Studio, click Tools > Options > Micro Focus > Directives > PL/I.
* A new page in the project and file properties enables you to set SQL directives on PL/I source files.

Preprocessors

IDE support is now available for selecting and using third-party preprocessors installed on your machine
and integrated with Enterprise Developer for building native COBOL Mainframe Subsystem applications.

A guide for third-party vendors and administrators showing how to integrate additional preprocessors with
Enterprise Developer is now available in the product help in the General Reference > Integrated
Preprocessor Interface section.
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Rumba Integration with Visual Studio

Visual Studio now offers context menu commands for launching the Rumba mainframe display (Desktop or
embedded) from Solution Explorer or from Server Explorer. The embedded Rumba display now provides
keyboard mapping and color settings.

You can use the display of choice both in debugging and when running applications.

Run-time Launch Configuration Files

Use a run-time launch configuration file to ensure an application can be launched when it is deployed in a
separate location to the run-time system (in the case of dynamically bound applications), or when the
licensing daemon is not already running.
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Known Issues

Known Issues

Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

ASP.NET

CICS

COBOL
Watchpoints

Documentation

It is not possible to run ASP.NET Web Sites or Web Services on a production
machine (one that has Micro Focus Enterprise Server installed) without an additional
setup. This is because the production machine does not contain development tools
such as the COBOL Compiler. To workaround this, you need to do the following steps:

1. Compile the site prior to deploying it using the Publish Web Site command in
Visual Studio.

2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and
delete the Language=""COBOL"" statement.

3. Edit the Web.conTig file with a text editor and delete the line which contains:
<compiler language=""COBOL". ..

4. Ensure that a .NET Server license is installed using Apptrack.

 An EXEC CICS DELAY statement may sometimes produce a difference of one
second.

The debugger ignores a COBOL watchpoint that is hit if there is no statement
following the statement that modifies the data on which that watchpoint is set.

* In Visual Studio 2012, clicking Help > Micro Focus Product Help > Product
Documentation results in the message "Cannot find requested topic on your
computer"”. If you see this message, click Micro Focus Enterprise Developer 2.2 for
Visual Studio 2012 in the Contents tab to display the documentation as expected.

» If you install Enterprise Developer for Visual Studio 2012 and its documentation is
not available in the Microsoft Help Viewer, perform the following steps:

1. In Visual Studio 2012, click Help > Add and Remove Help Content.

2. Choose the Manage Content tab.

3. Check the Disk radio button, then navigate to the folder containing the
Enterprise Developer for Visual Studio 2012 documentation. By default, this is
C:\Program Files (x86)\Micro Focus\<product name>\help.
Select helpcontentsetup.msha and click Open.

In the content list, click Add next to the Enterprise Developer entry.

Click Update.

Click Yes on the User Account Control and Microsoft Help Viewer 2.0 dialog
boxes to enable the update to continue.

No oA

The documentation for Enterprise Developer for Visual Studio 2012 is added to
the Microsoft Help Viewer.

/ Note:

This problem only occurs if you install Enterprise Developer for Visual Studio
2012 while documentation for Visual Studio 2012 is being downloaded or
updated, which typically happens when you install Visual Studio 2012 or run
it for the first time.



Enterprise .

S The Historical Statistics Facility may generate incorrect records for SSTM-enabled
erver

enterprise servers.

Expanded .
Copybook View
(in Visual Studio
2012)

When you add a COPY statement in a COBOL program and then show it in
Expanded Copybook View, the line for the copybook statement is read-only. If you
then perform an Undo in the COBOL program, the COPY statement is removed
while the contents of the copybook is still shown in the program.

* Replace All does not work inside the Expanded Copybook View

» For copybooks with file extensions that are not traditionally associated with
COBOL you must first add the file extension to the list of known copybooks
extensions in Tools > Options > Text Editor > File Extensions before you can
show them in Expanded Copybook View.

ICETOOL ICETOOL emulation for managed code is not available in this release.
Emulation

Installation « Before installing this release as an upgrade to an existing installation of the

previous version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is
to avoid some problems that might result in files not being installed. This is
required only on Windows.

« Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import
on the Enterprise Server Administration home page.

* When installing this product for Visual Studio 2010, if you already have Visual
Studio 2010 Isolated Shell with Service Pack 1 (SP1) installed, you might
experience problems with starting Visual Studio after the installation. This is a
Microsoft issue relating to the Integrated Shell (installed as part of the Micro Focus
product installer) overwriting some Visual Studio SP1 components. To resolve the
issue you need to repair Visual Studio 2010 SP1.

Micro Focus On versions of Windows Vista and later, Enterprise Server listens only on the IPv4

Rumba loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as Micro Focus Rumba may fail. To work around this issue, in
your emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

Native COBOL  On Windows XP, when building a native COBOL application in Visual Studio, a dialog
may pop up with error "Unhandled exception at 0xcO006866 in cobol.exe:
0xC0000005: Access violation reading location 0xc0006866)". This is caused by
Symantec antivirus runtime protection. To resolve this, you need to apply the following
fix from Symantec: http://www.symantec.com/business/support/index?
page=content&id=TECH97280&locale=en_US.

Resource Trying to deploy the local resource adaptor mFcobol-localtx. rar to WebLogic

Adapters may fail with a ClassCastException. To work around this issue, you need to deploy
mFcobol-xa. rar first, then need to undeploy this file and deploy the local one,
mFcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).

Visual Studio

DE » In the properties of a managed project, the Application page currently allows you

to select any of the static methods in the application as a Startup object. This is
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incorrect. You should always set only the first static method or the program name
as a Startup object in order for the project to build.

» Using Call Hierarchy locks the source files currently opened in the editor. To work
around this problem, you need to trigger a syntax check - for example, by making a
small change to one of the open files.
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Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

e .NET Compiler

e MTO -JCL ESMAC

e MTO -JCL MVS

e MTO - JCL System Catalog
e MTO - JCL Utils - IDCAMS
* Open PL/I Compiler

e Open PL/I Debugger

e Open PL/I RTS

e SQL: COBSQL

.NET Compiler
Back to the list

* In member reference in managed COBOL syntax, you may now only use parentheses when referencing
methods. You can no longer specify parentheses when referencing fields or properties, as this will
produce a syntax error. For example:

set intLength to testString::Length()

must change to:
set intLength to testString::Length

MTO - JCL ESMAC
Back to the list

» As part of an enhancement to improve performance of the spool display function, several new indices
have been added to the casspool .dat file. If you are upgrading from a previous release, you must
convert the casspool .dat file of any enterprise server created before Enterprise Developer 2.2
Update 1 to the new format before starting any JES-enabled enterprise server and submitting jobs to it.

This release provides the following scripts that convert the casspool . dat file to the new format:

* On Windows: Tixcasspool .bat in %COBDIR%\bin or %COBDIR%\bin64
e On UNIX/Linux: fixcasspool .sh in $COBDIR\bin

To convert the casspool .dat file, run the appropriate script from an Enterprise command prompt
using the following syntax:

¢ On Windows:

fixcasspool .bat <ol d-1 ocati on>casspool .dat <new- | ocati on><backup_fil enane>
e On UNIX/Linux:

fixcasspool .sh <ol d-| ocati on>casspool .dat <new- | ocati on><backup_ fil enane>

Where:
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» <old-location> - the fully or partially qualified location of the existing casspool . dat file, if not in the
current directory. Optional.

« casspool .dat - the spool file that will be updated. The file is located in the same directory as the
enterprise server's system catalog.

« new-location - the fully or partially qualified location where the backup file will be created, if not in the
current directory. Optional.

« backup_filename - the name of the file that will be a back-up of the old casspool . dat file. If the file
name already exists, the script terminates without converting the casspool .dat file.

If you do not convert casspool . dat, attempts to start the enterprise server fail with the following
messages:

JESO00011E Batch Spool File Error; Status [39]

JESO00130E Note JES000011 Error - New casspool indexes may need
generating. See error

description in product docs

2654417 (1090421)

MTO - JCL MVS
Back to the list

« The final disposition processing of temporary datasets has been corrected to be in line with the
mainframe processing, with a default value of PASS unless DELETE has been specified in the DD card.
Previously, the default value was DELETE.

2671175 (1091627)

« When running batch programs, receiving an "Out of Space" error requires operator intervention to
continue processing.

2642115 (1089055)

MTO - JCL System Catalog
Back to the list

* You can now use MGMTCLAS to provide an EXPIRE AFTER number of days. This is used to calculate
an expiry date for datasets allocated using the MGMTCLAS parameter.

2664639 (1090992)

* MFLEX*.DAT files were not being moved with spool files. Spool housekeeping now deletes LEX files
when it deletes JESYSMSG. Also, to identify any remaining orphan LEX files, the
MF_SPOOL_HK_LEX_SCAN environment variable sets spool housekeeping to scan the data directory
for LEX files older than the max retain period.

2659555 (1090759)

« Spool housekeeping has been rewritten to provide a number of new features. These will be described in
the product documentation.

(592452)

MTO - JCL Utils - IDCAMS
Back to the list
« The state of VSAM virgin files is now being correctly processed.

2686149 (1093587)
« A REPRO COUNT of zero is now processed as zero records to be included in the REPRO operation.

2665006 (1091034)
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Open PL/I Compiler
Back to the list

* On Intel platforms, the -bitsltr Compiler option can be used to store bit strings left-to-right within each
byte. This is similar to Big Endian bit ordering on Intel platforms. The Intel default is to store bit strings
right-to-left within each byte similar to the Intel hardware bit ordering.

2675860 (1092098)
e The libraries libmf_so, libespli.so and libespliz.so are no longer delivered. This is
transparent if linking PL/I objects using mfplx or Idpli, and no changes are needed to your build process.

However, if linking PL/I objects using either the UNIX |d command or the Enterprise Developer cob
command, you must include the libraries 1ibmfpli .so when linking stand-alone Open PL/I objects
(executed outside of Enterprise Server), or lHibmFpliz.so when linking PL/I objects executed under
the control of Enterprise Server.

To do this, use the option -Imfpli for stand-alone Open PL/I objects or -Imfpliz, respectively, for PL/I
executed under Enterprise Server. These options replace the —Imf option.

* Open PL/I applications must be recompiled and re-linked in order to use them with this release.

Open PL/I Debugger
Back to the list

« The debugger now stops before an ON UNIT triggers. This lets you perform debugging on the ON UNIT
itself. You can configure the ON UNITS the debugger stops on.

2674783 (1092319)

Open PL/I RTS
Back to the list

e Writing to SYSPRINT when running outside of Enterprise Server now drives output directly to the
terminal and does not buffer the I/0.

2477031 (1076203)

SQL: COBSQL
Back to the list

e COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)
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Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

* .NET Compiler

« .NET CICS (General)

¢« .NET ESQL Support

* .NET JCL (General)

« .NETRTS

e Adis

e Assembler Compiler: HLL Macro Assembler
* Assembler Program Execution

e CAS (COBOL App Server) General
e CAS Admin Console

e CAS Resource Manager Interface
« CAS Security

e CAS XA Switch modules

« CASRDO

e Compiler

» Compiler ECM Support

e CICS BMS Screen Painter

» Documentation

e ES Monitor/Control (ESMAC)

» File Handling - External File Handler
* File Handling - Fileshare

» File Handling - Sort / JCL Sort

e HCO for Microsoft SQL Server

e LE370 Support

« MDSA API for CAS

e MF Communications Server

e MF Directory Server

e MF Server Administrator (GUI)

* MFA: GUI components

*  MFA: Mainframe

« MFIO

* Micro Focus Heartbleed Update

e MTO - CICS BMS Screen painter
e MTO - CICS Communications

e MTO - CICS ECM/Preprocessor/Translator
* MTO - CICS Emulation

+ MTO - CICS ESMAC

e« MTO-IMS DB

e MTO - IMS MFS

e MTO - IMS Other

e MTO-IMSTM

e MTO -JCL ESMAC
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MTO - JCL MVS

MTO - JCL System Catalog
MTO - JCL TSO

MTO - JCL Utils

MTO - JCL Utils - IDCAMS
NCG

Open PL/I CICS Preprocessor
Open PL/I Compiler

Open PL/I Macro Preprocessor
Open PL/I RTS

Open PL/I SQL Preprocessor
RJSE - JCL

Run-Time System

SQL: COBSQL

SQL: DB2 ECM

SQL: HCO for SQL Server
SQL: OpenESQL

Visual Studio IDE

Web Service Client

XDB Server

XDB: Problems not classed above
XML Syntax Support Preprocessor
XML Syntax Support Runtime

.NET Compiler
Back to the list

When compiling for managed code with the RM(ANSI) directive, the EXIT PROGRAM statement now
works as expected. Previously, it was causing all files open in the program to be closed, which should
only occur if the RM directive (without the ANSI parameter) is specified.

2690872 (1093437)

(As 1091900) Previously, when the NOBOUND directive was set, generation of a level 88 condition
name on a subscripted item could result in a system error.

2685375 (1093076)

An INITIALIZE statement without the REPLACING phrase now initializes PIC N data items to DBCS
spaces (x"8140"). In a previous version, this was incorrectly initializing to ASCII spaces (x"20").

2682846 (1092779)

An INITIALIZE statement applied to a particular element of a subscripted group, where a space fill
should precede a sub-occurs item, now applies the space filling to the correct element of the
subscripted group.

2682845 (1092778)

A problem has been fixed where an INITIALIZE statement referencing a group that redefines something
did not function correctly if the group itself was not otherwise referenced.

2681790 (1092700)

Arithmetic statements involving subscripted operands no longer cause bad code generation. Previously,
this was likely to happen when the subscripted data item was declared at 01 level, or was declared
within a group, which itself was never referenced.

2677890 (1092368)
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In previous product versions, the event which was the target of an attach or detach statement could not
be specified as the end of a member reference chain. This meant that it was not possible to have
statements like:

attach method self::MyMethod to self::TextBox::TextChanged

This is now fixed.

2676123 (1092130)
Property initializers as part of the 'new' (constructor) expression are now functioning correctly.

2674668 (1091974)

Previously, when the NOBOUND directive was set, generation of a level 88 condition name on a
subscripted item could result in a system error.

2673571 (1091900)

Previously, a mixture of static and instance files within a class could result in bad code generation. This
has now been resolved.

2672322 (1091732)

Previously, in situations where a reference-modified move from a pic xto a pic n field has the same
length expression on each side, compiling produced incorrect code which resulted in the target being
truncated.

2670726 (1091595)

Type inference for generic methods is now working as expected. Previously, in certain cases, it was
causing 'COBCHO0829 Could not find method..." errors.

2670658 (1091643)

Programs compiled to managed code, and which use the SSRANGE directive, no longer produce
system errors at compile time.

2668437 (1091389)

After stepping into an INVOKE or a PERFORM statement, the call stack will now point to the INVOKE
or PERFORM itself, and not to the statement following it.

(583690)

When compiling for .NET, XML comments that are attached to types and members (for example,
methods and fields) now generate warnings if the XML text is not correctly formatted.

(595368)

Previous versions of the product allowed the caller of a method, in which the last parameter was an
array, to specify a list of zero or more arguments of the array element type, in place of a single array
argument. By default, this behavior is now only supported when the array parameter in the target
method has the PARAMS attribute. To restore the old behavior, the new ILPARAMS directive has been
introduced.

(599666)

Previously, the resolution of shortened type names (those without explicit namespace) could fail when
different programs had different ILUSING lists. This could occur when there were multiple programs in a
project and one or more of them had $set statements with the ILUSING directive.

(599903)

A problem where generic classes would wrongly appear to have errors on background parse has been
resolved.

(601182)

.NET CICS (General)
Back to the list
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The seelistener process in Enterprise Server for .NET no longer consumes excessive CPU when
certain TN3270 printer clients are connected.

2692412 (1093527)

In Enterprise Server for .NET CICS, SEND MAP ERASEAUP no longer resets the modified data tag of
fields (MDT) on the screen. This duplicates the behavior of mainframe CICS.

2690966 (1093406)

Output sometimes did not appear when printing to a Rumba 3270 printer from Enterprise Server
for .NET.

2683870 (1093091)

Enterprise Server for .NET was not resetting TDQ triggers correctly after the first trigger for a queue had
occurred.

2683584 (1092878)

In Enterprise Server for .NET, a transaction using EXEC CICS STARTBR that specified an FCT with an
invalid key/offset was causing an exception during task finalisation. This resulted in the task not being
removed from the request queue and the active tasks count not being decremented.

2682803 (1092816)

Connecting a 3270 printer to an Enterprise Server for .NET region was causing the seelistener process
to consume a large amount of CPU.

2681456 (1092653)

In Enterprise Server for .NET, the EXEC CICS RECEIVE MAP API no longer hangs if the data from the
terminal refers to a field that does not exist in the input map structure.

2677163 (1092258)
CICS regions could fail to start on local machines if very large resource definition files were being used.

2670293 (1091581)

In Enterprise Server for .NET, EXEC CICS RECEIVE MAP now correctly sets the field input length (to
0) and the input data (to low-values) when an empty field is received.

2668153 (1091454)

In Enterprise Server for .NET, BMS fields are now justified properly based on the use of the JUSTIFY
parameter in the BMS field definition or the presence of the NUM attribute if JUSTIFY is not specified.

2667621 (1091399)

You no longer receive an RTS 105 or RTS 200 when two or more transactions running in parallel
invoked an EXEC CICS LOAD.

2667508 (1091340)

EXEC CICS SEND MAP DATAONLY ERASEAUP no longer incorrectly resets field attributes which
should be preserved.

2667382 (1091990)

In Enterprise Server for .NET, the EXEC CICS RECEIVE MAP statements now correctly receive all
fields for maps where some of the fields are not defined in the order in which they appear on the
screen.

2667207 (1091319)
Enterprise Server for .NET now support the SEND TEXT NOEDIT CICS API.

2663897 (1091320)

Previously, double-clicking a file in the Spool or the Catalog views of the Enterprise Server for .NET
Administration Ul failed to start the File Viewer, if it was hidden.

(599906)

Previously, it was difficult to locate the public assemblies of Enterprise Server for .NET in the Visual
Studio Add Reference dialog as they did not have the prefix "Micro Focus".

Resolved Issues
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(599909)

Connection strings defined in the <MicroFocus . SEE> section of the machine.config file were
corrupted when the HCO for SQL Server tool "Manage Connections" updated the machine.config
file two or more times in a session.

(601595)

.NET ESQL Support
Back to the list

OpenESQL did not correctly handle EXEC ADO BIND CONNECTION statements that passed the
connection name in a host variable.

2681358 (1092636)
Previously, the OpenESQL precompiler split DBCS SQL statements which resulted in receiving a
managed OpenESQL run-time error when processing the statements.

2672260 (1091722)
The LIKE operator was not invoked properly for NET DATAROWS cursor search conditions.

2671820 (1091683)
Some consistency issues with sensitive cursors have been resolved in the ODBC, JDBC and ADO run-
time systems for OpenESQL.

2667592 (1091300)

.NET JCL (General)
Back to the list

In the Enterprise Server for .NET Ul, the "DS Org" and "RECFM" fields of the "Allocate New Dataset"
and "Edit Existing Dataset" dialogs now correctly show the currently selected value and the available
options in the respective drop-down lists.

2674486 (1091956)

NET RTS
Back to the list

An error when converting values from type decimal to other COBOL data types has been fixed.
2695116 (1093886)

Adis
Back to the list
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REVERSE-VIDEO now works as expected when using the X"AF" function.

2683509 (1092851)

MS ACCEPT statements now sound a beep when invalid characters are entered into integer or decimal
fields. Integer fields no longer accept invalid characters and normalise.

2680081 (1092542)
MS ACCEPT statements now display numerics with space fill and sign leading so that integers and
decimals are appropriately aligned.

2680081 (1092543)
The attributes specified in the screen section are now displayed correctly after a call to the X"AF"
function 81 has been made.

2650012 (1089634)



Assembler Compiler: HLL Macro Assembler
Back to the list

* The /PREPASM operand used with the BMS generator utility to invoke the MFASM Assembler to
expand copyfiles (MFBMSCL <bms_filename> /PREPASM) was affected by a long and spacey
filename fix to the MFASM command line handler that resulted in the Assembler macro processor not
running. The issue with the command line has now been fixed and COPY statements in BMS modules
are now expanded correctly.

2685507 (1093084)

Assembler Program Execution
Back to the list

* Previously, if you assembled and linked an Assembler module with the ANIM option turned on and then
you ran it under Enterprise Developer 2.1, and the ES_CONSOLE_SERVER environment variable was
not set to YES, an error 197 would occur as the Assembler run-time system attempted to bring up the
Assembler debugger and make screen displays from it. Now, if ES_ CONSOLE_SERVER is not set, the
Assembler run-time turns the debugging flag off and just zooms through the module without invoking
the Assembler debugger. Additionally, ES_CONSOLE_SERVER now accepts both YES or Y as values
and they can be either upper or lower case.

(596477)

CAS (COBOL App Server) General
Back to the list
e Multiple casout calls (using the -r option) in a single process now work correctly.

2694290 (1093800)
« When accessing TS/TD on error, the file status is now displayed correctly.

2684719 (1093023)
* HSF records no longer contain incorrect dates when a task runs past midnight at the end of a month.

2644616 (1089363)
* Messages issued from casstop are how sent to stdout.

2643162 (1089019)
« All system abend messages are now reported to the console.

(602933)

CAS Admin Console

Back to the list

* The JES Program Path and CICS Transaction Path now accept paths of up to 4096 characters.
2665324 (1091104)

CAS Resource Manager Interface
Back to the list

« Athread synchronisation issue was causing responses to be lost intermittently. For stateful requests,
this could result in lost SEPs (whereby a SEP would appear as busy even though it was not processing
any work).

2686429 (1093442)
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CAS Security
Back to the list

« A new user objectclass instance added to an LDAP-based external security manager now has its initial
login attempts count value set correctly.

2637659 (1088656)

CAS XA Switch modules
Back to the list
* The Declared Global Temp table is being dropped at CICS end of task with XDB as resource manager.

2682648 (1093069)
* A new SQL Server XA switch module provides support for xa_recover and also handles implicit rollback
by SQL Server more cleanly than previous switch modules.

2679162 (1092481)

CASRDO
Back to the list

» Clicking Resources > JES > Catalog in ESMAC now opens the initial screen without showing the
results of any previous searches.

2656391 (1090454)

Compiler
Back to the list

 LOCAL-STORAGE data in nested programs now behaves as expected and as it does on the
mainframe - as LOCAL-STORAGE of the main program.

2693843 (1093746)
« A MOVE from a group item to a DBCS target that requires padding nhow behaves as expected.

2692634 (1093553)
« DELETE statements that contain the END-DELETE scope terminator now compile as expected.

2690465 (1093235)
* UNSTRING on LINKAGE SECTION data items with reference modification could sometimes give the
wrong result.

2684812 (1092998)
* Using large EXEC SQL statements no longer causes the Compiler to hang.

2684713 (1092993)
e The ? NUMERO SIGN (U+2116) Shift-Jis FA59/8782 is now converted correctly to EBCDIC value 446e
under CHARSET(EBCDIC).

2683297 (1092823)
* MOVE figurative constant to PIC G item under CHARSET(EBCDIC) now returns the expected results.

2683091 (1092801)
« A MOVE CORRESPONDING statement with a GLOBAL subscripted target now compiles as expected.

2682557 (1092981)
e A program compiled with the FDCLEAR Compiler directive and containing a numeric file record now
compiles as expected.

2678050 (1092326)
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» The asterisk character is now treated correctly in COPY REPLACING text under mainframe emulation.

2676006 (1092571)

« Aliteral greater than 80 bytes but less than 160 bytes in length and containing non-ASCII characters
will now compile as expected with a mainframe dialect.

2670083 (1091560)
« Programs that contain EXEC INCLUDE statements inserted by a preprocessor now debug as expected.

2661838 (1091416)

e [S02002 and SNI table VALUE syntax is now working as expected for multi-dimensional tables that are
not directly nested within each other.

2651916 (1089808)

e The Compiler error message 62 (COBCH0062) has been clarified by changing "Nested COPY
replacement not supported” to "Nested COPY replacement causes termination of parent COPY
replacement".

(599823)
 The SQL TYPE DBCLOB(n) now creates the correct COBOL record structure.

(599679)

Compiler ECM Support

Back to the list

* The SQL(CHECK) option no longer incorrectly affects the setting of the unrelated NCG option 'CHECK'.
2685791 (1093351)

CICS BMS Screen Painter
Back to the list

* The BMS compiler no longer generates a MOD or copy file if errors or severe errors are encountered
during compilation. To revert to the previous behavior, where the BMS compiler generates a MOD or
copy file even if it encounters errors or severe errors, specify the /IE directive.

(595227)

Documentation
Back to the list

* You may now specify an SSL-enabled listener when submitting jobs via CASSUB. You achieve this by
using the tcpssl protocol on the /s or -s switch.

2671020 (1091619)

*  When creating a VSAM data set using the DEFINE CLUSTER command, records are assumed to be
variable-length, unless the NUMBERED parameter is used and the RECORDSIZE parameter specifies
the same length for the average and maximum record size, in which case, fixed-length is assumed.
2615989 (1088176)

e A compiler directive INIT-BY-TYPE has been provided to allow initialization of each data type to a
sensible value for that type.

2650462 (1091658)
* The INITIALIZE verb now supports multiple categories in a single REPLACING clause.
« Variable length record files that are 4 bytes or smaller are padded to 8 bytes.

2537147 (1081777)

< The installation instructions now list the required libraries for IBM System z (390) in the Software
Requirements section of the installation instructions of the product help.

Resolved Issues | 57



2683015 (1092919)

ES Monitor/Control (ESMAC)
Back to the list

« Inthe ESMAC (casrdo45) page, there is now provision to filter and list the members of a particular PDS.
The filter text is PDSNAME(*). The PDSNAME should be the complete name of the PDS, and cannot
contain any wildcards.

2500753 (1078391)

File Handling - External File Handler
Back to the list

« Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a
file status of 35 is returned, regardless of the access mode specified.

2692826 (1093604)

*  When using the RMFM File Handler, a file status '05' is returned when executing a DELETE FILE
statement, if appropriate. This emulates the behavior of the RM/COBOL run-time.

2685220 (1093089)

« Avrollback recovery of a REWRITE where the record size was being reduced was producing incorrect
results.

2685069 (1093085)

« When a DD name is associated with several concatenated data sets of different charsets, the returned
data has the charset encoding of the first data set. However, if the first data set is LSEQ, the returned
data has the charset encoding of the application program.

2677941 (1092434)
» cobfhrepro2 now produces the correct output for FCD2.

2664465 (1090972)

« A new environment variable, STRICTVSAM, has been introduced. When it is set to ON and under a
mainframe emulation, a file status of 37 is returned when you open an existing VSAM file for OUTPUT
and the file has or previously had some data written to it, or if the file format is different from the file on
disk. The default for this variable is OFF.

2660766 (1090639)

« When reading concatenated datasets, each dataset in concatenation must use the same RECFM,
either all FB or all VB.

2654517 (1091793)
 The FOLDER section in a file handler configuration file now supports relative paths.

2653787 (1090290)

« Btrieve files are now supported, using the xfh2btr call conversion module, for native COBOL, running in
a Windows environment.

2598434 (1086466)
* 64-bit fileshare clients would fail to connect if any cci configurations settings were used.

File Handling - Fileshare
Back to the list

e The Escape character was not being honoured for filenames passed to FSVIEW which caused
filenames containing $ to be interpreted as environment variables.

2660207 (1093021)
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MFJSORT now correctly displays the file status of a queried VSAM file, rather than a generic error
message, when the file being queried returns a non-zero file status.

2589273 (1092107)

File Handling - Sort / JCL Sort
Back to the list

When VLFILL is specified in OUTFIL, the variable length records smaller than the LRECL/OUTREC are
now correctly padded with the value specified in VLFILL rather than with spaces.

2680553 (1092622)

Under ICETOOL emulation, the maximum size of an ON Field for PD data type has been increased
from 8 to 31 bytes in order to emulate mainframe behavior.

2680285 (1092551)
The PARM options CORE, SIZE and MSG are now parsed and ignored.

2675829 (1092090)
After a SORT operation, the memory allocated by SORTTEMPSPACE is correctly freed.

2666797 (1091311)
MFSORT now correctly sorts NU fields when SORT-EBCDIC is specified.

2663772 (1090910)

HCO for Microsoft SQL Server
Back to the list

The NOSTMTCACHE SQL compiler directive option is invalid and no longer available when setting
SQL Preprocessor options from the IDE.
2694876 (1093861)

OpenESQL returned an error when a FETCH had more output host variables than the number of
available result columns; OpenESQL now ignores excess columns, resulting in improved compatibility
with DB2.

2694548 (1093840)

Previously, a problem occurred with DB2 YEAR() function when taking date duration or timestamp
duration as argument with the directive SQL(DIALECT=MAINFRAME).

2683713 (1092874)

Using FETCH OR SELECT INTO statements that have more output host variables than the number of
columns in the result no longer results in errors.

2676276 (1092708)

The SPD generator did not honor the EXTERNAL NAME option correctly during the generation of the
stored procedure wrapper.

2659338 (1090674)

HCOSS now emulates mainframe SET CURRENT SQLID and SET CURRENT SCHEMA statements.

2507765 (1078735)

LE370 Support
Back to the list

LE370 parameters that continue on the next line are no longer flagged.
2681691 (1092669)
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TSO ALLOCATE command emulation now supports the use of "F B".

2668742 (1091453)
An unsupported LE option in the code no longer invalidates the options that follow.

2668740 (1091425)

A fault that caused the data received by an EBCDIC program when a 'READ from SYSIN' was
performed to be in ASCII format has been corrected.

2657391 (1090401)
CEE3PRM now successfully retrieves the parm value to the calling program.

2654879 (1090140)

MDSA API for CAS
Back to the list

If an enterprise server instance is started by an Enterprise Server user account that has execute
privilege but not update privilege for that server, you now receive an INSUFFICIENT_ACCESS error
when the server starts.

2664445 (1091238)

MF Communications Server

Back to the list

When using casout to get job information, sometimes you could receive an error and the output was
trucated.

2693283 (1093638)

An issue where terminating 3270 sessions would result in high CPU usage in the MFCS process has
been fixed.

2682179 (1092886)

In version 2.2 of this product, the received data was missing from the trace messages for CTG and ISC
conversations. This has now been fixed.

2674286 (1091971)

Some of the Enterprise Server functions for informing running enterprise server of security updates and
for retrieving the list of printers available on the server system were broken in Enterprise Developer 2.2.
This has now been fixed.

(601260)
You no longer receive exceptions in MFCS when the data-trace option is enabled for a CTG listener.

(601465)

MF Directory Server

Back to the list

Resolved Issues

When using the export and import functionality of the MFDS XML Enterprise Server configuration, XRM
name and label definitions are now exported and imported correctly.

2683510 (1092852)

When using the export and import functionality of the MFDS XML Enterprise Server configuration, the
open and close string properties of XRM resources now support the inclusion of double quotes.
2682635 (1092777)

When adding or editing an IMS MPR definition in the Enterprise Server Administration GUI, you can
now use comma as a separator in the class field to enter multiple class definitions.



2676449 (1092164)
* The mfds export and import command line options -x and -g XML now also support exporting and
importing enterprise server script configuration information.

2668554 (1091412)
e XML import in the MFDS no longer fails if the XML source code contains long paths.

2668553 (1091409)

« When using the Enterprise Server Administration to edit the properties of JES Initiators, JES Printers,
IMS MPRs and XRMs, the GUI now rejects duplicate names.

2668020 (1091336)
e Session cookies in the browsers for the Enterprise Server Administration GUI now use the HttpOnly flag
for additional security.

2666975 (1091258)

« The browser auto-complete feature is now disabled for the password fields in the Enterprise Server
Administration GUI.

2666975 (1091260)

« If the Enterprise Server Administration HTML GUI is in "restricted access" state, a logged on user now
needs to have "administer user" levels permission to see the "Display" options in the LHS of the GUI.
This includes the "Directories", "Statistics", "Sessions" and "Journal" menu options. The "administer
user" option is available by default to any member of the #DSAdmin MFDS user group. In MLDAP ESM
security, this permission is defined by Update, Add or Delete ACE permissions against the "User
Administration” resource in the "Enterprise Server Administration" resource class under "Enterprise
Server Resources".

2663991 (1090934)

* When exporting the Enterprise Server configuration in XML format with the "mfds -x" command line
option, the MSS ISC and CTG listener information was not formatted correctly, which resulted in an
incorrect behavior when you reimported the XML configuration.

2651735 (1090147)

« When you use the Enterprise Server Administration HTML GUI to create a user group, the following
characters are no longer allowed in name: '< >',";', " and '&'.

MF Server Administrator (GUI)
Back to the list

* When trying to change a password from the Enterprise Server Administration HTML logon page,
additional checks are made before reporting the success or failure of the request.

2659582 (1090525)

* The execution scripts configured for an enterprise server instance can now use the credentials specified
on the Start\Stop page of the server in Enterprise Server Administration. For example, to use the
specified credentials to start an enterprise server instance, you need a script with the following
command:

* On Windows:

casstart /r%ES_SERVER% /Zu%TXUOPERATOR% /p%TXPOPERATOR%
¢ On UNIX:

$ES_SERVER, $TXUOPERATOR
Where:

+ TXUOPERATOR resolves to the user id.
« TXPOPERATOR resolves to the password.

After the enterprise server instance uses these environment variables, they are reset to blank and are
no longer available to query.
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2599100 (1086661)

MFA: GUI components
Back to the list
e Missing Sl characters no longer cause an abend. Incorrect DBCS character streams are now ignored.

2667289 (1091404)

» After the MFA server sends a 9/218 error ("Unsupported DCB/DSORG"), the data set is released and
can then be reallocated.

» If an x37 out of space abend occurs when running an MFDAS EXPORT command, the affected data
set is deallocated and available for use.

MFA: Mainframe
Back to the list

e The MFA server now works with CA Endevor R16.0. You will need to update your MFA and MFAE JCL
in order to use the new libraries.

2692338 (1093691)

MFIO
Back to the list
« MFGENER now works with the server using FCD3 protocol.

2676130 (1092134)
e The comments in the MFAVTAM sample member have been updated.

2674286 (1091976)
e SM2 no longer segfaults when a member has been deleted on the mainframe.

Micro Focus Heartbleed Update
Back to the list

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

MTO - CICS BMS Screen painter
Back to the list

« BMS COPY files will be found in the /SYSLIB folder when the /PREPASM directive is used to include
the COPY files.

2685507 (1093277)
* The message "BMSCH1101S COPY file expansion requires directive /PREPASM" is no longer
displayed if copy file expansion fails due to errors in the copy file.

2669082 (1091499)
« The BMS Compiler no longer fails with an access violation error when invoking a user pre-processor (/
PCOMP=...).

2669050 (1091679)
« The BMS Compiler no longer fails if the /MAP name exceeds seven characters. A message is displayed
and the name is truncated to seven characters.
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MTO - CICS Communications
Back to the list

When converting a transaction typed on a DBCS terminal from EBCDIC to ASCII, the conversion did
not use the length of the transaction but the length of the variable that was holding it. This has been
fixed and the conversion now uses the length of the transaction.

2676259 (1092144)

MTO - CICS ECM/Preprocessor/Translator
Back to the list

DFHRESP(TIMEDOUT) was missing from the CICS precompiler tables. The value has now been
added.

2675857 (1092238)

MTO - CICS Emulation
Back to the list

In CICS transaction routing, BMS Maps in DBCS environment are now displayed correctly.

2680118 (1092510)

When importing a startup list that had more than one group in it, only the first group was imported. This
has been fixed.

2659018 (1090500)
When the casprt process dies, it will now be restarted automatically.

2593342 (1086058)

MTO - CICS ESMAC
Back to the list

The ESMAC page now displays CICS TERM definitions correctly.
2676448 (1092163)

MTO - IMS DB
Back to the list

An IMS application written in PL/I could produce an unexpected error RTS114 in MFIMSEP.

2680509 (1092550)
A non-zero return code from an IMS application program written in PL/I now sets JES COND CODE.

2680115 (1092509)

IMS Data Capture exit routines were not called for the destination parent segment during update of a
concatenated segment in a logical DB when the logical child segment did not have an exit defined.

2676941 (1092370)

You could receive an error RTS 114 in MFIMSDBS if a BMP was killed after issuing a large number of
uncommitted database updates.

2671177 (1092024)
Previously, Roll Forward recovery was incorrectly asking whether to recover the same file multiple
times.

Resolved Issues
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MTO - IMS MFS
Back to the list

» Screen data in a conversational transaction is no longer misaligned when the first field after the
transaction code contains spaces.

2680867 (1092593)

MTO - IMS Other
Back to the list

e The message "OPEN ERROR ON MESSAGES FILE, STATUS=35 DSN=IMSWND.MSG" was
sometimes issued in place of an IMS error message, depending on the preceding program execution in
a JES initiator.

2665550 (1091186)

MTO - IMS TM
Back to the list

e IMS-TM no longer becomes unresponsive upon multiple application ABENDs.
2664063 (1091514)

MTO - JCL ESMAC
Back to the list

* When browsing the catalog via ESMAC, the maximum number of lines displayed is controlled by the
environment variable ES_MAX_CATALOG_LINES, which has a default value of 5000. This is
introduced for stability and performance reasons. If you wish to display more than 5000 lines, you need
to set the environment variable to a higher value in Configuration Information on the General tab in
MFDS. See "Setting Environment Variables for Micro Focus Directory Server" in the online
documentation for more information.

2671855 (1091696)

MTO - JCL MVS
Back to the list

* A new environment variable, JES_PRINT_SPOOL_MSG=[CONSOLE |LOG]SILENT], can be used to
control the disposition of the spool dataset printing message (JES000029I). Environment values are:

* CONSOLE - send the message to the console (default).

* LOG - write the message to a special log file named PRNT_SPL_MSG_YYYY_MM_DD.DAT where
YYYY_MM_DD is the current date. This file resides in the same directory as casspool.dat, and a
new file is created every day.

e SILENT - no message. Use this option with caution, as you will have no audit log of your spool
datasets.

Note: This environment variable is introduced for high print load users, where print messages to
the console impact system performance.

2660637 (1091746)

MTO - JCL System Catalog
Back to the list

Resolved Issues



In the MVSCATPB API, the second and any subsequent reads of catalog records for dynamic PDS
were not returning the extension lisy.

2685834 (1093098)

New empty dynamic pds members are now retained if they have been opened for output, to extend, or
for an update.

2681745 (1092834)
Deleting the JESYSMSG from ESMAC (casrdo43) now deletes all the associated files.

2659558 (1090837)

The last change date on the catalog entry for a dynamic PDS model is set to the current date when a
new member is added to the PDS.

2581611 (1091084)

MTO - JCL TSO
Back to the list

An issue related to temporary datasets later referred to as permanent ones has been corrected.

2676531 (1092360)

A problem when running batch programs with large parameters has been fixed. A parameter with length
of up to 100 characters can now be passed to the user program.

2671469 (1091663)

Previously, after a batch job using IKJEFTO01, a SEP was incorrectly terminating with CASKC0026E
Error unloading service " after IKJEFT step with DSN.

MTO - JCL Utils
Back to the list

Setting MFALLOC_PCFILE=Y would not create the file if RECM=LSEQ.

2682866 (1092920)
Using MFGENER to copy RECFM=VB to RECFM=FB no longer results in bad data in the output file.

2679429 (1092796)

When copying an LSEQ dataset to a dataset with no dsorg specified, IEBGENER did not correctly
assign the default dataset characteristics.

2663396 (1090889)
There is now an extra validation for EBGENER to check that the attributes of concatenated SYSUT1
files are compatible.

2654517 (1090132)

When a job deletes a GOO0O0V0O0 dataset belonging to a GDG, the DG manager updates its internal
BIAS/G00000V0O0 table to reflect it, so that subsequent references to the GDG via relative BIASes
within the same job are resolved the same way as on the mainframe.

2650338 (1089941)

MTO - JCL Utils - IDCAMS
Back to the list

An existing SYSIN of type Dynamisc PDSM no longer causes a failure.

2686421 (1093226)
It is now possible to use wildcards to specify the names of PDS members to delete.

2684823 (1093005)
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NCG
Back to the list

An error could occur at generate time for programs with calls to INTRINSIC functions that had multiple
ALL subscript parameters.

2695026 (1093885)

An issue in cob which caused a core dump when all entry points in the main program were invalid has
been fixed.

2663974 (1090927)

An issue has been resolved where the debugger would not step into the code when a PERFORM
statement is the last statement in a WHEN branch of an EVALUATE statement.

Open PL/I CICS Preprocessor

Back to the list

Passing the CICS Preprocessor option -optcics with exci=y results in the correct preprocessing to
enable batch operation with CICS connect if separate commands rather than mfplx are used to process
the program. For example, to correctly preprocess and enable batch operation with CICS connect for
the program pliexcit.pli, you would enter these separate commands:
mfpp -margins 2,72 pliexcit.pli -pp pliexcit.pp

mfexecpp -cics -optcics exci=y pliexcit.pp -ppcics pliexcit.ppc

mfpp pliexcit.ppc -pp pliexcit.pp2

mfpli -mvs pliexcit.pp2 -o pliexcit.obj

Idpli -mvs -dIl pliexcit.obj

2675232 (1092033)

A semi colon is no longer emitted within the comment with the -full_list macro preprocessor option
specified. Also, when using %INCLUDE, the generated comment line for multiple files included with a
single statement no longer erroneously contains the name of the file which included them.

2676504 (1092187)
COMMAREA no longer incorrectly passes to linked-to programs.

2667530 (1091299)

Open PL/I Compiler

Back to the list

66 | Resolved Issues

Using the concatenate operator with character varying strings now works correctly when compiled with -
opt.

2692333 (1093522)

A problem with a CHAR(1) repetition factor of 32765 causing the Compiler to loop indefinitely has been
fixed.

2684548 (1092979)
Procedures returning picture numeric data now work correctly when compiled with the -opt compiler
option set to 3.

2681995 (1092728)
A possible compiler abort when using the -map option no longer occurs.

2680528 (1092553)
A problem that caused a compiler abort with ONCODE 90011 no longer occurs.

2679977 (1092500)
A problem causing the XMLCHAR built-in to not work correctly no longer occurs.

2678830 (1092398)



e A problem causing the XMLCHAR built-in to not work correctly no longer occurs.

2678830 (1092399)

* Internal: The undocumented option -newalign was provided to Luigi B. et al for this functionality
specifically for NCG.

2675416 (1092054)
« A problem with Static structure assignments causing Error MFPLI01233E no longer occurs.

2675201 (1092023)
< A problem with binary integer constants in certain built-ins no longer occurs.

2675077 (1092015)
e A problem causing a Compiler Abort ERROR 2000A no longer occurs.

2673693 (1091875)
e Converting FIXED DEC to BIT no longer produces the wrong number of bits.

2673494 (1091883)

» The ODBC pre-compiler no longer incorrectly passes a long SQL statement to pre-compiler services
resulting in an MFPLIO1250S error.

2673288 (1091838)

< A problem with large string concatenation producing blanks and data loss during Restricted Expression
Evaluation no longer occurs.

2673288 (1092450)
« Unnamed structure members no longer cause compiler errors.

2673130 (1091820)

« When a BYVALUE parameter is greater than 4 bytes, such as a non-ideal argument that is not a true
immediate, the argument is now passed as -if enclosed by parentheses instead of generating a severe
error.

2667144 (1091256)

« A problem no longer occurs when passing a named constant of type pointer as an argument to a
subroutine.

2665622 (1091101)

* A program that previously triggered a SIGSEGV when compiling with the Open PL/I Compiler no longer
does so.

2645146 (1089173)
* The PL/I compiler now supports the REPATTERN built-in function.

2467971 (1075524)

Open PL/I Macro Preprocessor
Back to the list

* The macro preprocessor no longer generates extraneous additional linefeed characters when using -
margins with a %REPLACE statement where the new text exceeds the length of the original
%REPLACE constant text.

2692525 (1093557)

* The Open PL/I Macro Preprocessor no longer incorrectly handles the IBM deviation of the %INCLUDE
which used the format: %INCLUDE PDS(MEMBER); The Macro Preprocessor now parses for
"MEMBER" and uses the -isuffix and -ipath options to locate the %INCLUDE file.

2691090 (1093340)

e The macro preprocessor no longer goes into an infinite loop when incorrectly coding a macro
preprocessor function with missing parameters and punctuation.

Resolved Issues
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2682716 (1092764)
A %XINCLUDE is no longer skipped due when a prior %XINCLUDE is conditionally excluded.

2682455 (1092750)

When a PL/I Macro uses the STATEMENT option of the PROCEDURE statement and is invoked within
the input source using the keyword format without a trailing semi-colon, the macro preprocessor no
longer goes into an infinite loop.

2681527 (1092655)

When a macro generates a single line of returned CHAR data containing multiple logical lines and no
carriage returns, the returned data no longer wraps at or near 256 bytes if using the -margins option.
when using the -margins option, the macro preprocessor will now use the right margin as the point
where wrap is attempted. This results in the customer macro producing a comment that is formatted
similar to the mainframe format, providing an improvement over previous functionality.

2679415 (1092449)

The macro preprocessor no longer fails processing or flags a macro as having incorrect function
parameters if an unquoted period (.) is passsed to a macro preprocessor function.

2678366 (1092352)

When a construct such as '01'/'02'/'03' exists in source code without any spaces between the literal
constants and the divide symbols, a mismatched quote is no longer erroneously created by the macro
preprocessor, causing %lF to be incorrectly evaluated.

2677263 (1092243)

PL/I source code with mismatched single or double quotes and more than 16384 bytes before either
another quote terminator or and end of the file no longer results in a heap corruption and termination of
the macro preprocessor without first generating a preprocessed source deck.

2676511 (1092209)

Using the macro preprocessor -full_list option on a user program that had a syntactically incorrect
%INCLUDE statement no longer causes the macro preprocessor to trap.

2676508 (1092171)

PL/I programs using the macro preprocessor built-in functions COMMENT() or QUOTE() no longer
revieve warning messages, and the generated code is no longer different to what is generated on the
mainframe.

2675054 (1092006)
The macro preprocessor no longer erroneously generates an error message when a comment
containing a percent sign (%) is immediately preceded by a multiplication symbol (*).

2673315 (1091839)

Open PL/I RTS
Back to the list
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When using buffered file 1/0 that is flushed to disk as a result of an implicit or explicit CLOSE, the "out
of space" error now correctly raises a PL/I "ERROR" condition.

2680494 (1092560)

Previously, when transitioning from one IMS trancode to the next, the PL/I run-time system was not
initializing or deinitializing correctly.

2675644 (1092070)

The ANY and ALL built-in functions no longer produce the wrong number of bits.

2673494 (1091882)

If the EXTSM (sort engine) initializes but is not used, the sort engine now properly performs a clean-up
and de-initialization before any subsequent re-initialization. This allows the sort engine to be in a proper
state for subsequent calls to PLISRTD.



2672840 (1091787)

e The PL/I PLIDUMP facility has been enhanced to display information about the files which have been
accessed during execution if the "F" PLIDUMP option is specified.

2671365 (1092268)

< Invoking the DELAY() statement with a negative value no longer causes the application to sleep for a
longer than anticipated period given the specified value. The sleep period is now immediate.

Open PL/I SQL Preprocessor
Back to the list

* The OpenESQL pre-compiler sometimes incorrectly processed host variables in the FETCH INTO
statement for PL/I compiles, resulting in ES0109 errors.

2683997 (1092921)

* The DB2 pre-compiler incorrectly generated MPLIEO095S errors if a fixed CHAR host variable was
defined as greater than 254 characters.

2681503 (1092687)

e The DB2 pre-compiler failed to generate required code if the PL/I program had a one character name,
which resulted in severe MFPLIO0082S errors.

2681500 (1092774)
* A SQL preprocessor issue with using the [NODIALECT] option no longer occurs.

2677880 (1092301)
* The generated source code now contains %rdebug in the correct place.

2674774 (1091987)

« The SQL precompiler no longer incorrectly process PL/I programs with a particular language construct.

2673850 (1091889)

« Previously, you received an incorrect error message if an INIT clause in your code contained an
undeclared variable.

2673452 (1091871)

* The SQL preprocessor could generate code that resulted in Compiler errors if an END <program
name> statement was split over two lines.

2672588 (1091776)

RJSE - JCL

Back to the list

e MFA server can now import SYSOUT data sets with a maximum LRECL of 32K which is the system
limit.
2658439 (1090815)

Run-Time System
Back to the list

* When a container end event is received, all external files that are open in the container now close
correctly.

2513669 (1079282)

SQL: COBSQL
Back to the list

Resolved Issues
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COBSQL Pro*COBOL error messages displayed only up to 80 characters.

2681983 (1092788)

Previously, commented-out END-EXEC statements were causing a Compiler error. COBSQL now
ignores such statements.

2680341 (1092533)

The COBSQL precompiler was updated so it does not attempt conversion of source lines containing the
continuation character.

2663986 (1090930)

SQL: DB2 ECM
Back to the list

When a CREATE TABLE statement contained a PARTITION parameter, the HCO DDL processor
sometimes generated invalid DDL.

2682214 (1092725)

A new option (SAVEDDL) is available in the HCO DDL processor. With this option set, any DDL
converted from the input DDL file is saved and not executed. The DDL processor now supports
specifying the IN <tablespace> and COMPRESS <option> parameters but not modifying them.

2673448 (1091907)
Previously, the HCO IMPORT tool could go into a loop if the LOB column was in the import data set.

2673443 (1091887)

When compiling on a 64-bit systems, the DB2 pre-compiler incorrectly generated an error "DB0121
Package name is too long."

2673259 (1091920)
The HCO DDL processor now accepts column names greater than 18 characters. Previously, in this
situation, you received SQLCODE error -205 when the DDL was processed.

2673085 (1091829)

The HCO IMPORT tool now supports a new parameter (SAVEDEL) which enables converting DSN
import files to delimited format. When used with this paramter, the HCO IMPORT tool only converts the
file and does not perform an actual import.

2672865 (1091891)

The HCO Import Data tool was not checking for invalid lengths passed for VARCHAR column data; the
tool now checks this and when an invalid length is passed, issues an error message identifying the
affected column.

2661781 (1091056)

SQL: HCO for SQL Server
Back to the list

Resolved Issues

HCOSS now handles statements of type "SET hostVariable = CURRENT SQLID" correctly.

2693537 (1093690)

The HCOSS Assess Application Migration tool flagged CALL statements as errors without checking
parameter directions. These CALL statements are now flagged as 'in doubt' to initiate an assessment of
parameter directions.

2685247 (1093156)

The OpenESQL preprocessor and runtime now support AMODE(31) address pointers and swapping
COMP fields in SQLDA for user-defined mainframe style SQLDAS.

2684229 (1092978)



COBOL stored procedures could not perform database updates when called from a SQL Server trigger.

2680257 (1092809)
OpenESQL and HCOSS now correctly compile statements that contain CASE expressions.

2679336 (1092605)
OpenESQL now supports a generic syntax for setting and rolling back to transaction save points that
work with Oracle, DB2, and SQL Server.

2676145 (1092138)

Although mainframe DB2 supports FETCH INSENSITIVE from SENSITIVE STATIC cursors, which has
a SQL Server equivalent KEYSET cursor, SQL Server does not support FETCH INSENSITIVE from
KEYSET cursor. This is a permanent limitation.

2676140 (1092137)
OpenESQL did not support BLOB, CLOB, and DBCLOB host variables larger than 64K.

2649752 (1089622)

SQL: OpenESQL
Back to the list

OpenESQL did not support using the DB2 VALUES INTO statement with DB2 LUW.

2694069 (1093906)

The OpenESQL preprocessor incorrectly rejected host variable character definitions that contained
x'091' characters.

2692065 (1093465)

You can now specify SQL(NOCHECKSINGLETON) in applications that require compatibility with older
products to check for unfetched rows after a singleton SELECT. In such cases, the returned SQLCODE
value is zero rather than an error or a warning.

2691736 (1093420)

The SQL(TSTAMPSEP)compiler directive could not be explicitly set to a space character, for example
SQL(TSTAMPSEP=). This is now the default setting unless overridden by specifying
SQL(DIALECT=MAINFRAME).

2691212 (1093364)

In the IDE, the TSTAMPSEP directive was not listed as an OpenESQL compiler directive option.

2685702 (1093116)

When SQL(NODETECTDATE) is set after SQL(DIALECT=MAINFRAME), HCOSS does not attempt to
convert date, time or timestamp literals in static or dynamic SQL statements.

2685422 (1093615)

DB2 LUW applications could not use DECLARE GLOBAL TEMPORARY TABLE statements that were
not syntactically valid for DB2 z/OS.

2685219 (1093346)

The sqlda.cpy copybook could not be compiled using the ENTCOBOL mainframe dialect.

2682522 (1092825)
A new XA switch module is now available that supports XA recovery.

2680297 (1092528)
Previously, you would receive error COBCHO002 when SQL(NOPRE) was specified because the ODBC
precompiler would try to generate code using a variable which was not defined.

2679267 (1092438)

The OpenESQL pre-compiler generated code that swap COMP host variables incorrectly if the SQL
statement got an SQL runtime error.
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2677606 (1093013)

The OpenESQL precompiler sometimes incorrectly generated swap code for COMP host variables if
they were used for both input and output in same SQL statement which resulted in SQLCODE of +100
being returned.

2675122 (1092454)
A problem with SQL(CHECK) no longer occurrs when using binary host variables.

2673281 (1091832)
A problem with nested select queries in ESQL 'select into' statements has been fixed.

2672519 (1091768)

Previously, an incorrect code was generated for an INSERT statement that used an indicator variable
array when DBMAN=ADO was set.

2671938 (1091715)

The support for EXEC SQL GET DIAGNOSTICS has been extended to include DB2_ROW_NUMBER,
ROW_NUMBER and COLUMN_NUMBER as diagnostic items that can be retrieved by an application.

2670955 (1091611)

The OpenESQL preprocessor could sometimes improperly decode DBCS host variable characters
which resulted in receiving an "ES0109 Invalid data name" message.

2670725 (1091594)

The OpenESQL pre-compiler incorrectly changed the underscore character () to a dash character (-)
in an EXEC SQL WHENEVER statement.

2670723 (1091593)
Dynamic SQL statements were not releasing JDBC cursors.

2670548 (1091585)
OpenESQL for JVM COBOL prevented type byte[] host variables from being used.

2667023 (1091240)

The SQL Directives information available within the Visual Studio and Eclipse IDEs contained an error
regarding the available options for the XDB(DATE) and XDB(TIME) directives.

2666213 (1091185)

Some issues relating to the use of PIC G /PIC N DISPLAY-1 and some DBCS host variables have been
resolved.

When using Data Direct ODBC drivers, PIC N NATIONAL host variables always uses UTF-16 instead
of UTF-8 which previously happened on some platforms.

Some problems with using Data Direct's ODBC driver for Microsoft SQL Server have been fixed.

Visual Studio IDE
Back to the list

Resolved Issues

When using a continuous integration system (such as Team Foundation Server), it was not possible to
build any COBOL project unless the user account under which the builds were executed had been used
to start Visual Studio at least once.

2690873 (1093514)

When you use the Create Project From Existing Code Files wizard to create COBOL projects, it now
sets the output name or the assembly hame to match the name of the project and also selects the
correct build configuration.

2684455 (1092962)

When adding a file as a link to a virtual folder of a project when virtual view is switched on, the IDE no
longer creates a physical folder when you switch off the virtual view in Solution Explorer.

2676171 (1092151)



Opening the project properties for a Managed Procedural Multi-Output project from the context menu
now works correctly.

2672907 (1091794)
Creating a COBOL project in a directory containing DBCS characters could result in build errors.

2664439 (1090964)

Executables can now use run-time tunables without you having to set the COBCONFIG.BLOCK
environment variable provided that the Application Configuration file for the executable is located in the
same folder as the executable and is named <executable-base-name>_exe.mfgcf.

2644263 (1089150)

You now receive Compiler output when you are using MSBuild from the command line to build projects,
when the verbosity level is set to Minimum.

2617055 (1091210)

Managed COBOL programs that use RM/COBOL data file support now work correctly when you debug
or run them from within Visual Studio.

2609061 (1087614)

An issue where changing the project properties would not trigger a background parse has been
resolved.

In a managed COBOL project in which some of the programs contained errors, if you opened a
program that did not contain errors, it was sometimes marked as containing errors in Solution Explorer.
If you subsequently opened the program containing errors and fixed them, the errors would not be
removed from the Error List or from Solution Explorer.

If you specified that a virtual folder should include file extensions that matched the extensions of items
in the project, those items did not move to the virtual folder immediately.

Previously, copybooks on sequential lines expanded inline in the source code were incorrectly colored
as read-only though you could still edit the expanded code as expected.

When you specified project location and project type in the Create New Project From Existing Code
File wizard, if you added subfolders on the same page, the Next button would not be enabled.

When converting Net Express projects to Visual Studio solutions, the conversion no longer creates a
project named "<SolutionName> Shared".

Sometimes, it was not possible to type anything in a copybook expanded inline at the start of the line
immediately following the end of the copybook.

The column position for items in columns 128-256 appeared negative.

When Virtual View was enabled, adding a form, a WPF object or a settings file to a .NET project
resulted in an error.

Deleting a virtual folder that contained other virtual folders could cause the IDE to hang.

If you moved, renamed or deleted a virtual folder, turned off the Virtual Folder view and then turned it
back on, files would sometimes move to other virtual folders or disappear from Solution Explorer.

For native COBOL projects that contain dependencies on library files or objects that are not part of the
project, if one of those dependencies is updated and you rebuild the project, the project will be relinked
using those updated files.

If you used the REPLACE statement in a program, the Show All Copybooks command would have no
effect for that program.

The default debugging options for Native COBOL in Tools > Options > Debugging > COBOL are now
correctly enabled.

It was not possible to navigate to an item in another file, where the item was on a line number greater
than the number of lines in the current file.

You can now use the 'Submit JCL' context menu item for JCL files in a native Mainframe Subsystem
Application project when the project is not associated with any enterprise server. Using the command
creates a temporary server for the job submission.

The Add Existing Item dialog now includes a filter which enables you to add files of several supported
types at the same time.
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* When navigating to an error on a source line that contains tabs, the highlighted code sometimes did not
match the error.

» The Virtual View in Solution Explorer now provides a default virtual folder for service interfaces. The
folder does not show though for existing projects in which you have added your own virtual folders.

« Previously, it was not possible to debug a project using "Start Project" if the output name of the project
was specified on the "COBOL Link" tab in the project's properties.

e The Add Existing Item dialog now displays all supported COBOL file extensions, including any new
ones that you have added to the IDE options. If you configure the IDE options to add or remove file
extensions from the list of extensions for COBOL source files, you must restart the IDE before the
change to take effect.

« If an error or warning is detected in a copybook, the icon for the program containing the error will now
be updated to reflect this.

« The COBOL Source virtual folder now only contains files which can be compiled (which have their Build
Action set to Compile in the file properties). Files which were previously in this virtual folder but do not
compile will now appear in the Copybooks virtual folder or in the project root. Similarly, for PL/I projects,
the PL/I Source virtual folder now only contains files which can be compiled. Files that were in this
folder which do not compile will now appear in the project root.

« Copying block selections of code and pasting them in an expanded copy view no longer replaces the
selected lines of code entirely with the pasted text.

« If a source file that contains errors or warnings is added to the project as a link, it is now correctly
displayed in Solution Explorer with the error or warning icon instead of the link icon.

» If you created a virtual folder in Solution Explorer and specified file extensions for that folder that
matched the extensions of existing items in the project, the new folder could not be expanded to view
the files it contains.

« The members generated by the Implements Smart Tag are no longer inserted in unsuitable locations in
the code when the expanded copybook view is turned on in the editor.

< Show All Copybooks would not show a copybook if, though it itself could be shown, it contained
copybooks, all of which could not be shown inline.

« The following new default virtual folders are available in this release for non-Mainframe Subsystem
projects - Content (for HTML and ASPX pages), Styles (for CSS stylesheets), Scripts (for JavaScript),
Images (for bitmaps such as JPEG and PNG). For projects where you have created your own virtual
folders, or have moved files between the virtual folders, your changes will be preserved and will
override the new defaults.

* When adding existing files to a managed COBOL Mainframe Subsystem project, the Add Existing Item
dialog now includes filters that enable you to only show the supported file types.

e The options in Tools > Options > Text Editor > Micro Focus COBOL are now set correctly after
installing or updating the product.

« Changing the Build Action property for a file in a project configured to compile to multiple executables
no longer causes a rebuild of the entire project.

« Sometimes, when showing copybooks inline, it was not possible to enter anything at the start of the line
immediately following the end of the expanded copybook.

Web Service Client
Back to the list

« Support for nested COUNT IN clauses has been added to the generated Web Service Console Client.
Empty and unused array fields will no longer be returned in the client output.

2278428 (1066547)

XDB Server
Back to the list

« MFDB2UNL.CBL now allows the use of semi-colons within SQL statements.
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2661513 (1090755)

XDB: Problems not classed above

Back to the list

« Previously, TESTCOVER configuration could cause spurious errors in XDB utilities.
2677742 (1092299)

XML Syntax Support Preprocessor
Back to the list
* PREXML now handles conditional compilation correctly.

2665552 (1091113)
« An XML file being opened for input is now closed correctly.

2664760 (1091006)

XML Syntax Support Runtime
Back to the list

e The XML run-time system now handles non-US EBCDIC characters correctly.
2665518 (1091086)
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The WebSync service, where you can download fixes and documentation updates.
« The Knowledge Base, a large collection of product tips and workarounds.
« Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

y Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

e The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

e Your operating system version number and details of any networking software you are using.
* The amount of memory in your computer.

« The relevant page reference or section in the documentation.

« Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
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Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer

Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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